Getting Started

1. Start GenScriber.

The main window is split into several sections.
You can adjust the layout to your liking by dragging the separator bars between the sections.

The main window is split horizontally to separate the image area and the worksheet.

The topleft section has tabs for the images list, hints and picklists
(Some of these are not displayed until required.)

The 'Images' tab has its own set of buttons.

The bottom section is the data input area. To start adding data to GenScriber you need to open a document.
There are several ways to do this :-

o Create a new document by specifying column names
o Create a new document from a template
o Open a document from afile.

For more information see below.

If you are transcribing from images, you also need to open an image.

2. Select the image folder.
Click on the Image Folder button in the Images tag (top left) and select the folder where your register images are stored.

All usable images in the folder will be display in the image file list. Click on any listed image to display it.

Create a new document from a template

1. From the File menu choose ‘New Document  (From Template)'.

2. Select the template to use.
An empty document will be created from the template you chose.

About Templates.
For the user, there is not much to know about templates. Everything is done automatically.
There are two kinds of templates. Predefined and User (temporary).
Predefined Master Templates are stored in the templates folder.
These templates are shown inthe' New Document(from template) 'menu list, and allow easy reproduction of a worksheet.

A predefined (master) template may be created automatically from the current worksheet, by choosing 'Save Master
Template' from the 'Tools' menu, or you may create it manually, using a text editor.

User templates are automatically created and saved to the ‘'/include/tmp’ folder when the user exits the application.
These templates contain any options set for the current template.

When loading files, these templates will be used for any worksheets with the same column layout.

User templates will over-ride some of the options in matching predefined templates.

Open a document from a file

1. Fromthe' File 'menuchoose' Open Document File



You can also click the' Open File 'button in the worksheet toolbar.
2 . Locate and select the file(s) to open.

Note: Multiple files can be opened and merged automatically.
Use CTRL or SHIFT to select multiple files.

File types are allowed to be different, but all merged files must use the same template layout (column titles).
How to select files to merge.

When inthe' Open File 'dialog, hold downthe' Ctrl' or 'Shift' key to select multiple files.
Files will be opened in the order found on disk.

The name of the first file opened will be used as the filename, with -new' appended.
The resulting file will be CSV format.

example: filel.csv + file2xls + file3.csv = filel-new.csv

Create a new document by specifying column names

1. From the 'File' menu choose' Create New Document

2. Enter the template name. This is used as a reference (id). Use only alphanumeric characters, and no spaces. The
template name should not refer to the worksheet contents. It should refer to the template type, and column structure. Example:
census1841( IRL )

3. Enter the column titles.
Each name(title) must be entered on a separate line. Use only alphanumeric characters. Avoid using spaces. If you make mistakes
in the column names, don't worry, you can change them later in the '‘Column Options' tab.

4. Specify if it is a FullText document.

5. Whendone, clickon'Save' ,andanew document will be created. After you create a document this way, options will
allow you to change the column names and positions. you can also add or delete columns at any time.

Important note:  Column names(titles) must be unique and they must not contain special characters. The column titles are
used as a reference by some functions. Spaces in titles are allowed, but | suggest you do not use them.

The best way to format a title is to use 'medial capitals' in compound words, also known as camel-case.
ie. FatherSurname
or you could multihyphenate.

ie. This-Is-A-Long-Title or This_Uses_Underscore



The Image Viewer

A register image can be viewed in the top window while data is input in the bottom window.
Images may be rotated, zoomed and various filters applied.

The Image Folder List
The image list is displayed in the Images tab (top left). This is a list of images found in a folder selected by you.

Selecting the image folder.
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Click on the Image Folder icon in the Images toolbar and the folder dialog will open.

This is similar to a file dialog, but  you are only selecting a folder . All files will be greyed out.
Select the folder where your images are stored, and click '‘Open’
All usable images found in the selected folder will be display in the image file list. Left-Click on any listed image to display it.

Refreshing the image list
If images are added to the image folder while genscriber is running. The image list needs to be refreshed before the images
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will be available. Click the refresh icon to refresh the list.

Back to top

Image Zoom
The image may be zoomed via the toolbar or the image menu.
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Fit : Fits image into view area

Show image at original size

Zoom 10%  Sets the image zoom level
Zoom 20%  Sets the image zoom level
Zoom 30%  Sets the image zoom level
Zoom 40%  Sets the image zoom level
Zoom 50%  Sets the image zoom level
Zoom 60%  Sets the image zoom level
Zoom 70%  Sets the image zoom level
Zoom 90%  Sets the image zoom level
Zoom 80%  Sets the image zoom level
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Zoom 100% : (original size)
Mousewheel scrolls image up/down

CTRL+ mousewheel scrolls image left/right
SHIFT+mousewheel zooms image in/out



SHIFT+CTRL+mousewheel stretches images.
Click any of the zoom toolbar button to cancel stretch.

Setting the default zoom
Changing the zoom level via the top image menu will set a default zoom.
When a new image is loaded, it will open at the zoom level you last selected.
The zoom level is retained when the application closes, and is still set when the app is next opened.

Changing the zoom via the icon bar or with the mouse (shift/scroll), does not affect the default zoom level, and when the next
image is loaded it will revert back to the default zoom level.

The current and default zoom levels are displayed at the top right of the app.

Back to top

Viewing PDF Images ( >=ver. 2.7)

Pdf files containing multiple images are supported.

To list all images
To list all images in the pdf file, RIGHT-CLICK the filename and a popup menu will appear.
Choose ' List pdfimages , to list all images found in the pdf file. These images may be selected as normal images.
To return to the original image list, RIGHT CLICK the image list and choose' Return to Image Folder '

How to view PDF images (ver.2.6.9)
When selecting a PDF file which contains images, the first page is automatically selected and extracted.
To select a different page in a multiple image pdf file, DOUBLE-CLICK the filename and a popup dialog will appear. Enter the
number of the page to display, and that page will be extracted and displayed.

Pdf files containing a mixture of images and text are not supported

Back to top

Viewing images from ZIP files ( >=ver. 2.7)

ZIP files containing multiple images are supported.

When selecting a ZIP file which contains images, the first image in the zip is automatically selected and displayed.
There is an option in ™/ Tools>Preferences/Import/Export / * to choose the image type (jpeg or png).

The jpeg is faster loading, but slightly lower quality.

To list all images
To list all images in the zip file, RIGHT-CLICK the filename and a popup menu will appear.
Choose ' List zip images , to list all images found in the zip file. These images may be selected as normal images.
To return to the original image list, RIGHT CLICK the image list and choose ' Return to Image Folder

To view a single image
RIGHT-CLICK the filename and a popup menu will appear.
Choose ' View single zip image 'and a pulldown list of images found will appear.
Choose an image from the list and Click 'Open'’ to display it.

Zip files containing a mixture of images and text are not supported

Back to top

Image Filters

The Image filters allow changes to contrast, sharpness and colour tint. By default, the image filters are turned off.



To turn image filters on, go to the ' Image 'menu and select’ Show Image Filters
Using the image filters

Place the mouse cursor over the handle on a slider, and while holding down the left mouse button , drag the slider to the

optimal position.

The value will increase to the right and decrease to the left.

On slow computers, there may be a delay in image response to the changes.

The slider positions will remain in position when a new image is selected, but the filters will not be applied to the new image.
To re-apply the filter setting to the new image, just left-click once on any slider handle.

To reset the filter options, select’ Reset Image Filters 'inthe' Image 'menu.

Back to top

Image Marker

Version 2.4 and higher

Image marker option
A red image marker is available. A button in the image toolbar toggles the marker on/off. Extra tools appear on toolbar for
adjusting marker size and position. The marker is a visual guide only. It is not connected to the synchronization.
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Marker buttons left to right. open/close marker, left, right, up,down, expand vertical, shrink vertical, expand horizontal, shrink
horizontal, auto width.

Using the marker
Clickthe' open marker 'button and the marker will appear. The toolbar will expand to show the control buttons.

I have found that if the marker is set to the correct height for a line of text, and then the image is dragged into a start position,
it will syncronize quite well.
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Image Synchronization

Version 2.4 and higher

Synchronizing the image with movement in the worksheet.
The option to enable synchronizationisin' Preferences > Worksheet
Once enabled it can be turned on/off in the ' edit ' menu. It will work with or without the marker visible.
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When sync is enabled, an extra button is available in the image toolbar.

This button will open the sync editor for synchronizing the horizontal(columns) and vertical(rows) movement.
When using the sync editor, it is recomended to use the marker as a visual aid for positioning the image.

Synchronizing columns.

1. Selecta column.

2. Drag the image to the horizontal position to move to when you later select the column.
3. Click on the sync button.

It does not matter which order you sync columns, and it does not matter if the image columns are in a different order than the
worksheet titles.

The image horizontal position is synchronised with each selected column. So when you are adding data into the worksheet,
the image will step forward or backward to match the column you are editing.

Important:  You must set sync on the first worksheet column.  The first column is used later as a reference when setting


http://www.genscriber.com/genapps/_detail/genscriber/help/marker_buttons.png?id=genscriber:help:image_viewer
http://www.genscriber.com/genapps/_detail/genscriber/help/syncedit_24.png?id=genscriber:help:image_viewer

the offset. If the first worksheet column does not match any image column, sync it to the leftmost column in the image.
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Synchronizes the horizontal position of the image to the currently selected column.
The column name will be added to the list.

Removes synchronization from the current selected column.
Removes synchronization from ALL columns. This button will show/hide the a row height indicator.
il
-
This is just a visual indicator of the vertical movement (row height)
The row height is the amount of vertical movement in the image for each row in the worksheet.
Synchronising the start row

After closing the sync editor, the start row needs to be selected. This is to tell GenScriber the vertical position of the first row
starts in the image.

1. Select columnl of the row you want to set as the start row. If you are starting a new worksheet this will be the first row.
If you are adding to an existing worksheet, | guess it will be the next empty row.

2. Drag the image so that it is in the correct vertical position to match the worksheet row.

3. Rightclick in any cell in the row and choose 'Sync current row as start'


http://www.genscriber.com/genapps/_detail/genscriber/help/sync_editor.png?id=genscriber:help:image_viewer
http://www.genscriber.com/genapps/_detail/genscriber/help/sync.png?id=genscriber:help:image_viewer
http://www.genscriber.com/genapps/_detail/genscriber/help/remove_sync.png?id=genscriber:help:image_viewer
http://www.genscriber.com/genapps/_detail/genscriber/help/remove_sync_all.png?id=genscriber:help:image_viewer
http://www.genscriber.com/genapps/_detail/genscriber/help/show_indicator.png?id=genscriber:help:image_viewer

If you are transcribing a batch of the same type of image. You will need to repeat the above for each image.
Your start row will be the next empty row inthe worksheet.

Horizontal offset.
When working with batches of images it is usual that they were not centered exact when filmed.
To set the image horizontal offset...
1. Left-click in columnl.
2. Drag the image to the correct horizontal position for column 1.
3. Right-click in columnl and select 'Set column offset'.
GenScriber will add the new offset to the original column sync settings.

If the height is adjusted to minimum the marker becomes a line. Reduce the width to minimum for an upright line.

There is also an option in the image menu (at bottom) for moving the image up as you enter data.
It will only work in the worksheet at this time. It will move the image up and down as you move in the worksheet.
Increments are the height of the marker.

Turning sync off.
Right-click in the worksheet and select’ Turn sync OFF

Saving sync settings
Synchronization is automatically saved in the template when you save the worksheet. When the document is next opened it
will have retained your sync settings. You will however need to set the start row (see above).

Storing sync settings in master templates
If you create a master template from a worksheet containing synchronization, The current sync settings will be automatically
added to the master template.

You can also use control keys to move the image when not in sync...

In Preferences > Global 'Set Image Control Keys' must be enabled.
This will allow selecting and moving the image:

Worksheet Image Sync Options

1. Full auto ima%e sync vertic?l and horizontal
2. Inc image vertically manua&yﬂCTRHENTER)
3. Change'to next image (CT ENTER)

Ctrl+Enter In Worksheet: )
Option full SR;InC: Move to next row and s%/nc image to current cell.
Option Inc: Move to next row and move image up (marker height)
Option New Image: Move to next row and open hext image

Worksheet Image Sync Options

1. Full auto image sync vertical and horizontal

2. Incimage vertically manually (CTRL+ENTER)
3. Change to next image (CTRL+ENTER)

Ctrl+Y : Syncronise column when using autosync (worksheet only)




Shortcut Keysfor | mage Functionsin Worksheeta%nd TethPeorlences

(  Active when 'SetTmage Control Keys are enabled in Pr )

In Toals> Preferences > GJobal ' Set | mage Control Keys must be enabled.
Thiswil?alﬁ)w selec’ﬁ ng and moving thg? n%\gewit Con%sf Keys.

Asof 2,7.2 the contro| key haye changed. There were clashes with the Win10/11 operating system. The
new qwckzkeys sﬂoulo' W%Fk g}é NOW. g p g sy

In Windows; Alt+Period  (full sto tﬂ%{llastheim e movement mode.
InLinux; —Alt+Esc tgggl&st ?lm e ement mode.
InmacOS: Option+ESC™ toggles the image movement mode.

Thereare3modes’ Movelmage ', MoveMarker ',' SzeMarker '
Esc : Defaults to 'Move Image' mode.

In Move lmage Mode

Alt+Arrow Up : Move image up height of marker
Alt+Arrow Down : Move image down height of marker
Alt+Arrow L eft : Move image left width of marker
Alt+Arrow Right : Move image right width of marker

In Move Marker Mode

Alt+Arrow Up : Move marker up
Alt+Arrow Down : Move marker down
Alt+Arrow Left : Move marker |eft
Alt+Arrow Right : Move marker right

In SizeMarker Mode
Alt+Arrow Up : Reduce marker height

Alt+Arrow Down - Increase marker height
Alt+Arrow L eft : Decrease marker width
Alt+Arrow Right > Increase marker width

Tfexh%ﬁfje '|rr?§8ee C aﬂcepigtl\il%nl'ssel ected In Textpad Preferences
CtFI+Enter ; Movgs image up percentage of %arker as set In Image menu > Set Image Inc)

If 'Enable Image Ch ' |Sselected In Textpad Preferences . .
_ CtFIrJrEnter g. :Wﬁ?%%angethegldsplay Pmageto the next image in the list rather than
incrementing the image.

Back to top



Main Menu Bar

File Edit Image Tools Applications Help

The main menu is always at the top of the application.

The sub menus will change to suit either the worksheet or textpad.

File Menu

Open Document
Open or Import an existing document.

Create New Document
Create a new document by specifying the column titles.

New Document From Template
Create a new document from a predefined (master) template.

Save
Save the current document, using the current filename.

Save As
Save the current document, will ask for a filename.

Export
Export current worksheetas HTML , BMD,FRG,CEN, GHF and XML, plus a number of other formats may be
available, depending on your options.

Choose Image Folder
Choose a folder of images for the image list.

Quit
Quit the application

Edit Menu

The edit functions are only available when in edit mode.

Copy All
Copies all data from current worksheet to the clipboard.

Copy cell contents
Copy the contents of the current cell to the clipboard.

Paste to cell
Paste the contents of the clipboard into the current cell.

Paste Image Name to cell
This will paste the name of the currently displayed image into the cell being edited.

Cut cell contents
Delete the contents of the current cell.

Paste, from cell above
Copy the contents of the cell above, and paste into the current cell



Get Value from cell above
Copy and paste the contents of the cell above.

Find and Replace in current column
Search the cells of the current column for the 'Find' text and replace with the 'Replace’ text.
This only replaces complete cell contents. partial content is not replaced.
Example: If Find = Brown, then Browne would not be replaced.

View This Link
Only available when in a cell containing a hyperlink. The hyperlink will be launched in the default application for the
media type.

Image Menu

The image menu refers to the image area only.

Choose Image Folder
Choose the folder where your images are kept.

Reset Image Filters
Reset all image filters to zero.

Show Image Filters
Toggle image filters ON/OFF

Negate
Transform image to negative

Grayscale
Transform image to grayscale

Colour
Transform image back to colour, from negative or grayscale

Set Default Zoom
Sets the default zoom level

Set Image Inc of Marker  Set the image increments in percent of the marker height.
This is applied in the TextPad when using the Ctrl keys below are used.

o Alt+Enter : Moves to next line in the editor and moves the image up the chosen percentage of the marker
height

o Alt+CursorUp : Moves the image up the chosen percentage of the marker height
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Alt+CursorDown
: Moves the image down the chosen percentage of the marker height

Tools Menu

View/Edit Info Headers
Only available when a GHF, FreeBMD, FreeCEN or FreeREG export option is selected.

Save Master Template
Only available if a master template does not already exist for the current document, or 'Template Protection' is disabled.

Create Conditions Script
Only available in admin mode 3, (and if a conditions file does not already exist for the current document).



Preferences
Change application options and preferences. Any changes made will be saved automatically when you close the
Preferences dialog.
See Preferences for more information

Applications Menu

The Application Menu allows execution of external applications.

File Edit Image Tools Help

Images &% CsvFile Search l P

& Translation Editor

Contrast | 11 —— Townlands of Ireland

Sharpen [ Age Calculator

Tint [ & Soundex Calc
% Batch Soundex Calc

RG12-4093-47 jpg & Relationship Calc
RG12-4093-48.jpg
RG12-4093-49.jpg |
RG12-4093-50.jpg
RG12-4093-51.jpg

Roman Mumeral Converter

Editing the menu items
From the 'Applications’ menu, choose 'Edit This Menu'.
The menu editor will open.
Add the app title and the app path. Browse to an application using the file button to the right of the app box.
Applications in the system path (firefox, gedit etc. will only need the name).

Applications'Menu Editor ]
App Title 1 App Path 1 1
[ l [thmEIIestesktUpksv‘f\\esearchicsv‘fllesearchS ] |
= &
App Title 2 App Path 2 ;
[Translat\on Editor l [fhoma»’lestanScr\berfmyappsftr’ans\ation_ed\torftreditor ] | 1
App Title 3 App Path 3
[Towntands of Ireland | [homeriesiGenserinerfmyappsiTownlandsireland Townlandsofireland_minri¢ | 5] £
ok
App Title 4 App Path 4
[Age Calculator l [fhumE»’IestenSmben‘myappszgeCaldAgeCaIculate_Mind6 ] @l
App Title 5 App Path 5
[Soundex Cale l [fhomaIIestanScr\ben‘myapps!SoundaxCa\cISoundex(alcimlnd6 ] | |
App Title 6 App Path 6
— [Bat(h Soundex Calc l [fhnmailestanScr\hen‘myappslBatchSnundex}BatchSnundax_Minﬂ 6 ] @l
| AppTitle 7 App Path 7
[Relationsh\p Calc l [fhomailestanScr\berfmyapps!RaIa(ionshipCaI(iRe\ationsh\pCak_Mmd 6 ] @l
| AppTitle 8 App Path 8
} | [Ruman Numeral Converter l [thmEIIestenSmben‘myapps!RDmZNumIRUmZNum ] @l
—| App Title 9 App Path 9

The maximum allowed menu entries is 10.
If an application does not run, check the app name or path you entered.

Application name/paths must be for executable files only. Trying to execute a non-executable file (such as a .pdf) could
cause GenScriber to stop responding while it attempts to run the file. If this happens, be patient, GenScriber will time out
and continue to run after several seconds.

Note to advanced users...

You can change the 'Applications' menu title if you wish. To change the menu title, you must edit the genscriber.ini, and
add the following line...

APP_MENU_TITLE = your_menu_title


http://genscriber.com/index.php?pid=28

Replace 'your_menu_title' with the title you want to use. If this line is not added, the default title is ‘Applications'.
GenScriber must be restarted if you edit the genscriber.ini.

Help Menu

The top item in the Help menu is 'Online Help'. The latest help is always available online. Other helpfiles may be
outdated.

All other items in the help menu are dynamic, and the menu items will vary depending on which help files are stored in
the 'include/help’ folder.

Adding you own help files
Your own help files and instructions can be added to GenScriber very easily.

Any file placed in the 'help’ folder will be displayed under the 'Help Menu'.

When one of the help menu entries is selected, GenScriber will attempt to display the selected file using the system
default application for that filetype.

The 'help’ folder path is 'GenScriber/include/help’.

Usual file types are: PDF, TXT or HTML , but files such as JPG,GIF,PNG may work too.




TextPad Area

Textpad is a stable, non-volatile editor. Unlike some wordprocessors, it will not change your text as you type it.
Dates and numbers stay exactly as you entered them.

Textpad works much like any other text editor. It saves RTF as default, but it will also open and save plain TXT files.
It can be set to be only a plain text editor by disabling all richtext tools in the toolbars.
The toolbar options can be set in Tools>Preferences>Textpad.

The textpad and worksheet work independently. The textpad files you edit and save have no connection to the
worksheet. You can of course copy/paste data between the worksheet and textpad.
Just click the tab to switch between them. The menus and toolbar changes accordingly.

You can set the 'Data Input Type' in Tools>Preferences>Global. It can be either worksheet, textpad or both. By
default, genscriber uses both.

Important note:  Textpad is not vunerable to any RTF exploits. It does not use Microsoft functions and is not
integrated with Windows.

TextPad Toolbar

=1 worksheet ||E Column Options | [ TextPad
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The Textpad Toolbar options can be found in Tools>Preferences>TextPad

Textpad settings
In the top half of the dialog there are the general Textpad options. These options apply to both richtext and plain text.

Toolbar position
The textpad toolbar has only one button size, but it can be repositioned.
If you move the toolbar left or right when Font and Style tools are selected, it looks a bit ugly because of the width of
the items.

Richtext toolbar options
In the bottom half of the dialog ' RichText Toolbar Options 'you can turn on/off various toolbar buttons.

If you prefer plain text instead of richtext, just turn off all the richtext options and genscriber will automatically disable
richtext editing.

The TextPad Picklist

The textpad picklist is resizable, floating window. It will remember the window size when genscriber closes. The
picklist will store phrases to use later. Much like an enhanced clipboard.

Genscriber will automatically save the current picklist, when you close the picklist or genscriber.

The number of picklists are limited only by available memory.

The following functions are available.

Copy to the ﬁi cklist fromthe docunent.

Paste fromthe picklist to the docunent.

Insert a newiteminto the picklist.

Append an itemto the picklist.

Edit an itemin the picklist.

Delete an item fromthe picklist.

Move positions of itens up and down the picklist.
Sorting the list.\\



Opening The PickList

¥
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| TextPad

There are 2 ways to open the picklist in textpad

1. Click the icon in the TextPad menubar

2.Use SHIFT_CTRL_P keys
or
3. Choose ' Picklist 'fromthe' Edit 'menuinthe main menubar

To Paste from picklist
Select the cursor position (or text) in textpad and ...
Click* Paste ’icon on picklist toolbar.

e

Double_Click item in picklist.
or
* Right_Click ’itemin listand choose * Paste To Document ’from the context menu.

or

Copy to the picklist

Select text in document and...

* Right_Click ’selected text and choose * Copy to picklist ’from the context menu.
or

* Right click ’in picklist and choose * Copy from document
or

Click* Copy ’icon on picklist toolbar.

Insert into the picklist.
Select item in picklist and click 'Insert' icon

4
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or
" Right click 'on a picklistitem and select' Insert 'from the context menu and the click ' Edit

=

Note: The insert will be above the current item.

Append an item.
Clickthe* Append ’icon.

=

and then click the ' Edit 'icon.

"icon
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Edit item in picklist
Select item and click ‘Edit’ icon.

E

or Right click and choose ‘Edit’

To remove an item from the picklist
Select item in picklist and click * Delete ’icon on picklist toolbar.

-

or Select item in picklist and press the ‘Del’ key

or ‘Right Click’ item in list and choose ‘Delete This Item’ from the context menu.

To sort the list.
Click on the top (grey) bar above the list. Each click will rotate through ascending/descending/unsorted.

Resizing the cells in the list.
The height of each cell (row) in the picklist is independently resizable to allow viewing more of the text.
Use the mouse to drag the cell boundary up/down.
The cell sizes will default back when the picklist is reloaded.

Expanded view of cells.
The contents of each cell in the picklist may be expanded for better viewing.
Click the expand icon in the picklist toolbar and a window will open.
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This window will show the content of a cell when you click on the cell.



La liste du dossier d'images
La liste des images est affichée dans l'onglet
Images (en-haut a gauche). Il s'agit de la liste

A des images trouvées dans le dossier (répertoire)
que vous avez sélectionné.

g/Sélection du dossier d'images.
Cliquer sur l'icéne du dossier des images dans la
barre d'outils Images le dialogue de répertoires
s'ouvre.
Il est semblable a un dialogue de fichiers mais
vous avez seulement un répertoire sélectionné.

Sélectionner le répertoire ol vos images sont
4 stockées, et cliquer ‘Ouvrir’

Toutes les images utilisables trouvées dans le
¥ dossier sélectionné sont affichées dans La liste
H des Fichiers images. Cliquer-gauche sur

n'importe quelle image pour l'afficher.

Rafraichissement de la liste des images.
wées dans le dossier Si des imaaes sont aioutées au dossier auand
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Filtres d'image
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Les filtres d'images permettent des modificat
- I o 2 el .

«ctionnée et extraite.
om du fichier et une

<
| e

Clicking on the expand icon again will close the window.

The window is resizable. It may be positioned as you like. When it is closed, genscriber will remember the window
position when it opens again.

Choosing a picklist
Click on the main menu, * Edit/Choose Picklist *menu.
All your picklists will be here.

Creating new picklists.
New picklists may be created on the fly.
Click on the main menu, * Edit/Create New Picklist '
Fill in the name of your new picklist and click Ok.
An empty list will appear in the * Edit/Choose Picklist *menu.

Select the list and add items to it.

Location of the saved picklists.
The picklists are stored in ‘genscriber/include/tp_picklists/.

The picklist may be edited in a text editor.

Important:  The each item in the picklist is terminated with a hidden vertical tab character (\v ).
If you edit a picklist directly. You must use the - character at the end of each item.
Genscriber will recognise this character and replace it with the correct hidden char.



The textpad.txt file is the default picklist. If it is deleted, it will be created automatically by genscriber, when you add
anything to it.

Notes about the picklist edit window.
The editor is resizable plain text editor. It has 2 buttons, * Save ’'and‘ Cancel
It uses the usual editing keys.

CTRL+A Select all

CTRL+C Copy selected text
CTRL+V Paste selected text
CTRL+X Cut selected text
CTRL+Z Undo
CTRL+SHIFT+Z Redo

PgUp Page top
PgDn Page bottom
Home Page left
End page right

Backspace Erase to left
Del Erase from right



Worksheet Toolbar

BEHG o gled ¥ EECER 70

This is the worksheet toolbar. It can be placed top, left, right or bottom of the worksheet.

Button Actions

=
=
E

Open File : Opens a csv file.

Save File : Saves the current file

Add anew row : Add a new row at the end of the file.

LW

Insert arow :Inserta new row at current position

Delete row : Delete the current row.

g

Jump to top row

[
|

¥
l

When filling, if you choose to not overwrite, then only empty cells will be filled.
1
|
-
When incrementing, if you choose to not overwrite, then the increment will stop at the first cell containing data.

This will copy a single row of data to the clipboard and format it suitable for use in other applications.
Two formats are available.  List and Tabulated By default List is used.
To tabulate data, hold down CTRL key when clicking the Copy button.

Jump to first column

Jump to last column

Jump to last row

Fill column : Fill column with value of cell above.

Increment : Increment column cells from cell above.

Special Copy



How to copy. The data copied will be from the current cell to the end of the row. Or from the start of the
row to the current cell, if the SHIFT key is held down when clicking the Copy button.

Example to copy as List
1. place the cursor in the row you want to copy, in the column you want to start copying from.
2. Click the Copy button.
The row is copied and formatted from the current column to the last column.

Example formatted as List
FirstName: John
Surname: Hunt
BuriedBy: Joshua Brookes Chaplain
Relationship: son
MotherFirst: Mary
MotherSurname: Hunt
Source: LDS Film 2356998
Parish: Manchester
Church: Cathedral
Register: Burials 1792-1800

How to copy as Tabulated
1. place the cursor in the row you want to copy, in the column you want to start copying from.
2. Hold down CTRL and Click the Copy button.

The row is copied and formatted from the current column to the last column.

To copy Tabulated and from first column to current column, Hold down CTRL and SHIFT when clicking the
Copy button.

Example formatted as Tabulated
First,Surname,BuriedBy,Relationship,MotherFirst,MotherSurname
John,Hunt,Joshua Brookes Chaplain,son,Mary,Hunt

[B]

Special Paste

Lock/Unlock Data

Lock or unlock the worksheet edit mode. Prevents accidental editing when viewing data.
Find and Replace: Open Find & Replace dialog. Do not confuse this with the Search Filter at
the bottom right of the worksheet

Help:  Show help



Worksheet Area

Find and Replace

Find and Replace in a column
Do not confuse this with the 'Search Filter'. There is no connection.

Find and Replace can find and append, prepend or replace text in a selected column.

To open the find and replace dialog press Ctrl+F
or Choose' Find and Replace 'from the edit menu.

Using the Find and Replace dialog

1. Choose a search method.
Search methods.
EXACT MATCH: Search criteria must match the entire cell contents exactly.
BEGINS WITH: Search criteria must match the beginning of cell contents.
CONTAINS: Search criteria can be anywhere in the cell.
REGEX: Search criteria regex patterns should be grouped using brackets (). The 'replace’ text groups
should match the regex pattern.

2. Choose a Replace method.
Replace Methods.
REPLACE with: Replaces any match found with the 'replace text'
APPEND with: Appends any match found with the 'replace text'
PREPEND with: Prepends any match found with the 'replace text'

3. Choose a column to search.

4. In the Search' field
Enter the search criteria.

5. In the Replace field
Enter the text to replace, append or prepend here.

6. Click 'Find/Replace'

When a search method of 'BEGINS WITH' or 'EXACT MATCH' is selected, any replaced, appended or
prepended text is applied to the entire cell contents.

The search method 'CONTAINS' will replace only the found text. Append/Prepend is applied to the found
text and then inserted into the cell contents.

Example for '"APPEND' using '‘CONTAINS'
Searchfor' ABC 'and Append with' DEF '
If cell contains:' ABCGH ‘'thenresult=' ABCDEFGH .

Note: When using 'BEGINS WITH' or 'EXACT MATCH',youcanusea * to'APPEND' or 'PREPEND'
all cells.
The 'replace text' will then be added to contents of ALL cells in the chosen column.

Split and Merge

Split and Merge Column Data
This action cannot be undone after it has been confirmed



Warning! This action canneot be undane.

Split this calumn and merge inte this column
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How it works
Split and Merge will make a single split in a columns contents and merge the data from the split into
another column. By default a 'space’ character is used as the split criteria.
Note: The split is applied down the complete column contents. There is no option to split a single cell.

When choosing how to split

FROM RIGHT : This will split at the first matching separator from the right of cell contents.

FROM LEFT : Split at the first matching separator from the left of cell contents.

ALL : This will take all the cell contents.

REVERSE : This will split and reverse the cell contents, and then write the result back into the
originating cell.

The split is always at the first matching separator.

Example: Split from right, using 'space' with an empty merge cell, Split cell contents =  Mary Jane
Thomson
Results: Splitcell=  Mary Jane , Merge cell=  Thomson

When choosing how to merge
PREPEND : Merge to begining of cell contents.
APPEND : Merge to end of cell contents.

The separator character is normally preserved during the split. Unselect' Preserve separator 'to
remove the separator. This option effects the split cell and the merge cell.

A space is added during the merge. To remove the 'space’, select’ Merge without space

How to open the split and merge dialog
Choose 'Split and Merge' from the edit menu, or right-click in a cell when in edit mode and choose from the
popup menu.

The Split/Merge dialog will disable non related options when selections are made. For example:- When
choosing 'REVERSE' the merge options will be disabled.

The Split and Merge dialog

1. Choose a column to split.
The cell contents are split at the first matching separator found in the cell contents.
Example:-
Split cell contains: Mary Jane Thomson
Split on 'space' (from right) and merge into empty cell)
Split results: Split cell= Mary Jane, Merge cell = Thomson.

2. Choose a column to merge into
The merge column can be any column in the worksheet

3. Choose how to split



FROM RIGHT: Split from the right of cell contents.

FROM LEFT: Split from the left of cell contents.

ALL: This will take all the cell contents.

REVERSE: This will split and reverse the cell contents, and then write the result back into the originating
cell.

4. Choose how to merge.
PREPEND: Merge to beginning of cell contents.
APPEND: Merge to end of cell contents.

5. In the 'Separator' field
Enter the split criteria. Just leave empty to use the default separator (space).

6. Preserve separator
The separator character is normally preserved in the cell contents after the split.
Unselect this if you want to remove the separator character during the split.
This option effects the split cell and the merge cell.

7. Merge without 'space’
A space is normally added between the merged text and the cell contents.
Select this only if you do not want a space when merging. This selection effects only the merge cell.

8. Click 'Split/Merge’
When a Split/Merge is applied, a confirmation dialog will appear. Check that the split was successful

BEFORE you confirm. If you answer 'Yes' it cannot be undone. If you answer 'No', the column data will be
restored to the way it was before the split.

The Search Filter

Do not confuse this with 'Find and Replace'. There is no connection .

Opening the search box
Look at the bottom right corner below the worksheet. You will see a button with a magnifying glass and
arrows. Click it and a search box appears.

Closing search
To the left of the search box is a button with arrows. Click this to close the search box and cancel all
filtering.

How to search
To search anywhere in the worksheet, just type in the criteria and press 'Enter’ or click the button to the
right of the search box.
The search is not case sensitive.
The search will look for the search criteria anywhere in a cell.
For example: 'Rob" will match Robins,Robinson,Roberts etc.

Any records that match the search criteria will be shown. All other records will be hidden. Don't panic. All
your records are still there, you just can't see them.

Searching in a specific column

You can specify the column(s) you want to search.

To specify a column, use' column_name==criteria
Notice that double equals areused (== ).

Example: Surname==hardy will return only records where' hardy 'was found in the"
Surname ' column.

Multiple column can be specified by seperating the criteria with commas.

Example: FirstName==john , Surname==hardy

This will search for any records that have ‘John' in the 'FirstName' column ~ AND  'Hardy' in the
‘Surname’ column.




Notes in hyperlink columns

Notes can be attached to any hyperlink column.
A link to the note is automatically added to the cell. The link may be activated whilst editing a cell to allow
viewing and modifying the note.

Notes found in columns to be used as NOTE or SOUR in gedcom file export will be embedded into the
gedcom, and are not required when tranfering the gedcom.
In all other cases the notes (txt files) need to be available to the worksheet.

Note Editor
The note editor is a simple plain text editor. The note files should always be saved with a .txt extent.

Special Key Actions in note editor CTRL+A  Select all
CTRL+C Copy selected text
CTRL+V Paste selected text
CTRL+X Cut selected text
CTRL+Z Undo
CTRL+SHIFT+Z Redo
PgUp Page top

PgDn Page bottom

Home Page left

End page right

Backspace Erase to left

Del Erase from right

Multiple hyperlinks in a single cell

If you have a need to link back to multiple images, it is possible to have any number of hyperlinks in a
single cell.

How to put multiple Hyperlinks in a single cell.
This function uses a base path with a hash ( # ) place holder, and then a list to be used as links.
Separate everything with commas. Each link will consist of the text before the # , and the '# will be
replaced by each item in the comma separated list.

Examples... If you add a hyperlink to the cell containing ./images/mylmage#.jpg,1,2,3 it will
exportas 3 separatelinks( 123 )
The links willgo to  ./images/mylmagel.jpg , ./images/mylmage2.jpg and

Jimages/mylmage3.jpg

If you add a hyperlink cell containing  http://www.myweburl.com/#, image.jpg, file.pdf,

webpage.html itwillexportas 3 separate links with names image.jpg , file.pdf and
webpage.html

These links will go to
http://www.myweburl.com/myweburl.com/image.jpg
http://www.myweburl.com/myweburl.com/file.pdf
http://iwww.myweburl.com/myweburl.com/webpage.html

If the urls are all different, do it this way...
http://www.# firstwebsite.com/image.jpg,secondwebsite.com/image.jpg

The result is 2 links...
http://www.firstwebsite.com/image.jpg
http://www.secondwebsite.com/image.jpg

Predefined Picklists



The PickList Files
The picklists are just text files, one item per line. They are stored in the' GenScriber/include/picklists
' folder.

Picklists must have a ".txt' extent, and must be pure ascii text. (Use notepad++ to create them)
Give the lists meaningful names. They will be used in a dropdown selection later.

Note: Whenever the picklist files are changed, GenScriber must be restarted to show the changes in
the dropdown lists.

Adding predefined picklists

1. Copy your predefined picklist files into the folder ‘GenScriber/include/picklists’

2. Start GenScriber ( if it was already running, then restart )

3. All picklists will now be available in the ' Worksheet Options 'as a dropdown list in the '
FixedList 'column.

The' FixedList 'column only shows when a worksheet does not have an associated master template,
or if you over-ride template protection.

If you turn off' Template Protection 'in'
changes you like to all templates.

Preferences ', GenScriber will allow you to make any

If you want to hide the 'FixedList' column, then you need to edit the master template manually, and change
'PICKLISTDROP=1" to 'PICKLISTDROP=0' in the template header.

If you want to use different predefined lists in another template, using the same column layout, you need to
make the template unique.

You can do this, and still show the same column titles to transcribers.

See Adding a unique ID to a column

Note: when you selecta' FixedList ', you must also setthe' Picklist 'optionto' Yes

Keep picklists to areasonable size.
Remember, not everyone has this months power processor.
Large picklists will slow down GenScriber, and on older computers, it may even become unusable.

What is a reasonable size?
Good question. The first thing to consider, is how many picklist are you using? All lists are held in memory,
so the total number of items has to be taken into account.
Keep in mind also, that the user may turn on Predict and AutoComplete for the cell. This draws a lot of
processing power on large lists.

| would say from my experience, That on a PC with 3GB ram, a total of 12000 items would be a maximum.
Provided that there are less than 3000 items in a single list.
On less powerful systems this would reduce considerably.

I would suggest, try keeping each list below 1000 items, and only use when really necessary.

Comma and Quote Replacement

By default, commas and quotes are allowed in data cells.

The use of commas and quotes can be prevented, or replaced by another character.
This optionis setin' Preferences ' (or by editing the genscriber.ini file manually).

Changing in Preferences.
1. Select Tools > Preferences from the main menu.
2. Selectthe' Worksheet 'tab.
3 . Choose the required actions inthe ' Replace Commas 'and' Replace Quotes 'options.

Options are automatically save when you close preferences.



http://genscriber.com/help/index.php?pid=100

Editing the genscriber.ini file manually.

COMMA=0 comma will be removed.
COMMA=1 commas are allowed.
COMMA= # replace comma with the ascii character code #.

The # value may be any ascii code 32 to 126.
Example: COMMA=59 (59 is the semicolon).
Example: COMMA=32 (32is a space).

Note: Default value is 1. (allow commas)
IMPORTANT: Do not use any of the microsoft editors to edit the genscriber.ini file. That
includes Notepad.
There are several free text editors available that will not corrupt documents. Get One.
QUOTE=0 double quote will be removed.
QUOTE=1 double quote is allowed.
QUOTE= # replace double quote with the ascii character code #.

The # value may be any ascii code 32 to 126.
Example: QUOTE=39 (39 is the single quote).

Note: Default value is 1. (allow quotes)

Special Key Combinations

CursorLeft Move left 1 cell
CursorRight  Move right 1 cell

Note:-
The above keys change with the navigate option. If in edit mode, and the left/right cursor keys are
set to navigate, the cursor will move inside the cell being edited.

CursorUp  Move up 1 cell
CursorDown  Move down 1 cell

Ctrl + CursorUp Move selected row up.
Ctrl + CursorDown Move selected row down.

Home Jump to first column, current row.
End Jump to last column, current row.

Ctrl + Home Jump to first column, first row.
Ctrl + End Jump to last column, last row.

PageUp Jump up visible page (if 10 rows visible, jumps 10 rows)
PageDown Jump down visible page

Ctrl + PageUp Jump to top row, current column.
Ctrl + PageDown Jump to bottom row, current column.

Ctrl + H Hide current column.
Ctrl + F Find and replace in current column.

Ctrl + R Repeat value of cell above, paste into current cell.

Ctrl  + + Addnew row.

Ctrl + C Copy selected text to clipboard.

Ctrl + V Paste clipboard to current cell.

Ctrl + X Cut selected text and copy to clipboard.
Ctrl + Z Undo last action in current cell.

Ctrl + S Save current data file.

not



When Picklist is active, and an item is selected:-
Ctrl + K  Add picklist item to current cell.
Ctrl + D  Delete selected picklist item.

Esc Cancels edit mode.

Ctlr + Enter Start new line.
When entering data in the worksheet, you can start a new row before reaching the end of the current row,
by pressing' CTRL + ENTER ' This will return to the start position, on a new row. The default start
position is column 1, but it may be set to any other column.

To set the start column.
When in edit, and in the column you wish to set as start, press’ CTRL + > ' This will set the
current column as the start position. Now when you're entering data, you can press' CTRL +
ENTER ', and you will be returned to this column, on a new row.

To cancel the start column press' CTRL + < ' This will return the start column to 1.

Sorting

Standard Sorting
This allows multi column sorting of rows. Sorting is as simple as clicking on the column header.

GenScriber does not have the sorting problems associated with spreadsheets. It will never destroy your
data. The rows cannot be broken by sorting, and it is easy to return to the original order.
To sort dates, see 'Special Sorting'.

Sorting is disabled by default.
To activate sorting, select' Allow Sorting 'in' Tools>Preferences>Worksheet '

Sort by any column
To sort a column, click on a column title. Each click will toggle between ascending, decending, and then
back to unsorted. A small arrow in the title will indicate this.

Sort by several columns
The multisort will allow you to sort by more than one column.

To multisort. First click a column header to sort it, then hold down the CTRL key and click on another
column header.

To return all columns to unsorted, release the CTRL key and click a column title until the column as
returned to unsorted.

Special Sorting
In addition to the standard sorting, there are a few special sorts. These are inthe right-click and
edit menu . The sort order is always ascending.

Sort as date
This will sort dates.
Because genscriber data is always text, and the dates you enter are always left the way you intended
them, the date sort has to do something that no spreadsheet can do. It has to sort the dates as text without
knowing which format you used.

Numerical date formats
USA and UK numerical formats cannot be mixed. There is no way for genscriber to know if 02/08/1580 is in
february or august.

The UK date format can be selected in  Tools>Preferences>Html Settings

USA
8/23/1850
8-23-1850

OR
UK
23/8/1850
23-8-1850



8/1850

Mixed format
All of the formats below are automatically detected, and sorted. Even when each cell in the column has a
different format.

Aug 23 1850

23 Aug 1850

23 August 1815
1850 aug 23
1850/08/23
Aug/1850
?/aug/1850
August

About Aug 1850
1850

Free text expressions like ' about mar 1850 'or' 1stqtr 1850 'will be sorted into the correct year,
and in some case the correct month, depending on the amount of actual date information provided.
However, an expression like ' first qtr 185? 'doesn't really stand a chance of being sorted as a date.

Sort backwards by word
This sorts backwards (right to left), starting with the word on the right of the data.
| find this useful for grouping locations and full names.
Example: 'Sheffield, Yorkshire, UK' would sort 'UK Yorkshire Sheffield' and 'Michael Hardy' would sort
'Hardy Michael'.
The sort order is always ascending.

Sort by last word
This sorts by just the last word in the cell data.

Example 'Michael John Hardy' would sort only on 'Hardy'. The sort order is always ascending.
Sort backwards by char

This sorts backwards (right to left) by character, starting with the character on the right of the data.
Can be useful in grouping data. The sort order is always ascending.

Special Copy

use in other applications.

Special Copy : This will copy a single row of data to the clipboard and format it suitable for

Two formats are available. List and Tabulated
By default 'List' is used. To tabulate data, hold down CTRL key when clicking the 'Copy" button.

How to copy.
The data copied will be from the current cell to the end of the row.
Or from the start of the row to the current cell, if the SHIFT key is held down when clicking the 'Copy'
button.

Example to copy as 'List'
1. place the cursor in the row you want to copy, in the column you want to start copying from.

2. Click the 'Copy' button.
The row is copied and formatted from the current column to the last column.

Example formatted as 'List’
FirstName: John
Surname: Hunt
BuriedBy: Joshua Brookes Chaplain



Relationship: son
MotherFirst: Mary
MotherSurname: Hunt
Source: LDS Film 2356998
Parish: Manchester
Church: Cathedral

Register: Burials 1792-1800

How to copy as 'Tabulated'
1. place the cursor in the row you want to copy, in the column you want to start copying from.
2. Hold down CTRL and Click the '‘Copy" button.

The row is copied and formatted from the current column to the last column.

To copy 'Tabulated' and from first column to current column, Hold down CTRL and SHIFT when clicking
the 'Copy' button.

Example formatted as 'Tabulated'
First,Surname,BuriedBy,Relationship,MotherFirst,MotherSurname
John,Hunt,Joshua Brookes Chaplain,son,Mary,Hunt

Special Paste
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multiple records formatted as tabulated data.
The data can be taken from other applications (another instance of GenScriber, excel, openoffice etc.), or
from websites that display formatted records in tables.

The special paste will paste from the clipboard, either a single record formated as a list, or

' Smart Paste' is on by default when pasting. This can be turned off in the Paste dialog if required.

When 'Smart Paste' is ON
The clipboard data must contain column titles in the first row.
Column order is not important. Column titles are compared to the existing worksheet, and any columns with
matching titles will be pasted into the correct columns.
Any remaining columns that do not match will be discarded.

Example: If the worksheet columns are titled “Dog, Cat, Mouse” and the paste data titles are “Cat,
Mouse, Elephant, Dog”, then Elephant will be discarded and Dog,Cat and Mouse will go into the correct
columns.

Create New Document
There is an option in the Paste dialog to create a new document. The purpose of this is to allow you to start
a new document with the correct column titles for the data you have in the clipboard.

When you select 'Create New Document' from the Paste dialogue, the dialog to create a new document will
open, and any column titles found in the paste data will be entered for you.

When 'Smart Paste is OFF'
Data is pasted 'As Is'. Even if column titles do not match.
This is useful for cases where there are no column titles.
Be careful with this. It is quite easy to end up with data that is not relevent to the column title.

Example: If the worksheet columns are titled “Dog, Cat, Mouse” and the paste data titles are “Cat,
Mouse”, then the 'Cat' data will go into the 'Dog' column, and 'Mouse' data will go into the 'Cat' column.



Worksheet Column Options

The Worksheet Column Options are available from the '

Column Options 'tab

(above the worksheet). Column options are available for all documents.

worksheet

Column Options

XM= @

WorkSheet Column Options

|Cn|umn Title

Colurnn Wisible

width

surname

Toolbar buttons

k Show/Hide advanced options

‘.‘;} Turn template protection on/off

jﬁnj Make all columns visible

Restore default options

e Show help for column options

To set a column option ' double-click 'the option cell or '

'. This will put the option into edit mode.

Show

100

left-click 'once and press' Enter

Column options are applied to the template not the file. The settings will be used for all worksheets
which use the same template as the current worksheet.




Column Title

If the current template is a master template, the template protection will turn on automatically.
The column titles can only be edited if template protection is turned off.
Template protection is always disable for user template.

To turn off template protection:-
L:.;-.
N '5'}
Click on the toolbar icon. This will toggle template protection on and off.

To edit the Column title, double-click the title and edit mode will start.
To Append, Delete or Move a column , right click on the title when NOT in edit mode.

Also, Ctrl+ up/down arrow (cursor keys) will move column positions.
Important note:

Columntittes must be unique, and they mustnot contain special characters. Column titles
are used as a reference by some functions.

Spaces in titles are allowed, but | suggest you do not use them.

The best way to format a title is to use 'medial capitals' in compound words, also known as camel-
case. ie. FatherSurname.

You could also multihyphenate ie.  This-Is-A-Long-Title or This_Uses_Underscore

Column Width

Width  : The column width. This is the pixel width not character width.
The width of any column may be changed.
Column widths are saved with the user template options, and applied when the file is next loaded.
User setting for column widths will over-ride those of a predefined master template.

Column widths may also be changed by dragging the worksheet column title edges.

Column Visible

Choose yes: Columnisvisible,or no :Column is hidden.

Columns may be hidden from view when not needed. Data in hidden columns is not be affected, and
all columns are included when saving files.

Note: Column 1 cannot be hidden.

You can show all hidden columns by clicking the 'Show All' button

Advanced Column Options

Advanced Column Options are always disabled by default. .

To enable advanced options click the
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icon in the column options toolbar.

PickList Option

no: Do not use picklist.
yes: Create and use picklist.

Any column may have a picklist associated with it. Picklists are lists of previously entered data for a
column. As you enter data into a column it is added to the picklist automatically.

The picklist option does not force anything into the data cell. It just sits there and waits for you to use
it.

Double-Click  a picklist item to paste it into the current cell.
You can also use Ctrl+K  to do the above.

There is an option to have the picklist predictive, and an extra option to have predictive text in cells.
To turn on Predict and Auto-complete in cells, go to preferences.

Note that 'Predict’ and 'Auto-complete’ will work only for columns which have the 'Picklist' option
selected.

Predefined picklist may also be added. See 'Predefined Picklists'

AutoCopy

AutoCopy copies the value of the cell above when editing.

no : No auto copy.

yes : Copy the value of the cell above. Do not overwrite existing data.

yes (overwrite) : Copy the value of the cell above and overwrite existing data.

It would not make sense use both Autolnc and AutoCopy at the same time. Therefore, Autolnc and
AutoCopy settings are parsed in the following order:  Autolnc > AutoCopy
So if you set both Autolnc and AutoCopy, the AutoCopy setting will be ignored.

Autolnc

Autolnc  automatically inserts an increment into the worksheet cells when editing.
no: No autoincrement.
FromCurrent:  From current cell value. Use the current cell value and increment to the bottom

row.
FromTop: Increment from top row to bottom row (use top row value as start)

AutolmageRef

Automatically copies the name or path of the current image viewed to a cell when leaving the cell (if
the cell is empty).




AutoCase

AutoCase forces data entry to upper/lower characters as required.
no : No autocase.

SentenceCase(strict) : First character is uppercase. All other characters are forced to lowercase.

SentenceCase : First character is uppercase. All other characters are left as entered.

TitleCase(strict) : (camel case) First character of each word is uppercase. All other characters
are forced to lowercase.

TitleCase : (camel case) First character of each word is uppercase. All other characters are left as
entered.

UpperCase : Force all uppercase.

LowerCase : Force all lowercase.

MaxChars

MaxChars Sets the maximum characters allowed for each cell in this column.

Omit the value or enter 0 (zero) to disable the restriction.
The default is empty.

Hints

Hint:  Add or edit hints for this column. Leave blank for no hint.

Hints are there to give basic instructions about the data input for a particular column. Hints may be
part of a predefined master template, or notes entered by the user. Any changes made by the user will
over-ride those in a predefined master template.

Fixed List

FixedList : Select a predefined picklist
The predefined picklists are just text files, containing a list,one item per line. They are stored in the '
genscriber/include/picklists ' folder.

Picklists must have a' .txt 'extent, and must be pure ascii text. (Use a text editor i.e.notepad++
(not a wordprocessor) to create them) .
Give the lists meaningful file names. The filename will be used in a dropdown selection later.

Note: Whenever the picklist source files are changed, GenScriber must be restarted
to show the changes in the dropdown lists.

Adding predefined picklists
1 . Copy your predefined picklist files into the folder
GenScriber/include/picklists '

2. Start GenScriber ( if it was already running, quit and restart it)

3. All picklists will now be available inthe ' Worksheet Options
dropdown listin the' FixedList 'column.

as a

The' FixedList 'column will be shown to the user, even when a worksheet has
an associated master template.

Note: whenyou selecta' FixedList ', you mustalso setthe' Picklist 'option

to' Yes '



Hyperlink Option

Hyperlink Column Option : When selected, the data in each cell of the column will be processed
as a link to media.
The view link is activated, link will open the media in the default application set for that type of media.
This allows for different types of media in each record of the worksheet.
pdf,images,web images, web pages,doc files and anything else your system can open.
Example: http://www.genscriber.com/mycensusimage.jpg

The pal: links used by familysearch.org are automatically expanded to the full url.
For example: If a cells datais  pal:/MM9.1.1/M568-BTS , it would be processed as
http://lwww.familysearch.org/pal:/MM9.1.1/M568-BTS

Viewing linked media
There are several ways to view the linked media.
1. Press CTRL+L whenina cell This will work regardless of edit mode.

2. When in edit mode. From the top menu, select Edit > View This Link
“This Link” refers to the hyperlink in the current cell.

3.  When not in edit mode. Right-click onacell and choose' View This Link 'from the
popup menu.


http://www.genscriber.com/mycensusimage.jpg
http://www.familysearch.org/pal:/MM9.1.1/M568-BTS

Preferences

i Updates Help

! Validate GenScriber

Edit Info Headers ’

The Preferences dialog allows you to change a number of options in GenScriber.
Preferences can be found inthe' Tools 'menu.

Any changes you make will be saved automatically when you close the Preferences dialog.

Grid Preferences

Grid Layout

Show Horizontal Grid
Show the worksheet horizontal grid lines.

Show Vertical Grid
Show the worksheet vertical grid lines.

Highlight Selected Row
This will highlight the row you are working on. Useful in worksheets with many columns.

Show Row Number
Display a fixed left column of row numbers.

Row Height
Set the height of the worksheet rows.
Requires a file reload for setting to take effect.

Default Cell Width
This will set the default cell width when loading worksheets that do not have template settings. It
is initially set at 100 pixels.

Grid Colour
Sets colour of the worksheet grid lines

Background Colour
Sets the worksheet background colour

Font Settings

Font Colour
Sets the worksheet text colour

Font Bold
Sets worksheet text to bold



Font Size
Sets worksheet text size

Worksheet Preferences

Scan Column Titles
GenScriber expect the first line of a csv file to be the column title.
If this option is selected, genscriber will scan the first line to try to determine if it has column titles.
A preset list of titles is used for recognising column titles.

Allow Condition Scripts
This will allow a conditions script to run, if one exists.

Allow Sorting
This allows standard multi column sorting of rows, and special sorting of dates etc.

Standard sorting
To sort a column, click on a column title. Each click will toggle between accending decending and
back to unsorted. A small arrow in the title will indicate this.

To multisort. First sort a column, then hold down the CTRL key and click on another column
header.

To return all columns to unsorted, release the CTRL key and click the column title until the
column as returned to unsorted.

Special sorting
To sort dates, right-click in a cell of the column to sort and select the special sort type. 'Sort as
Dates', '‘Backwards' etc.

Small toolbar Buttons
Reduces the size of the toolbar buttons.
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Worksheet Toolbar Position
The worksheet toolbar can be placed top,left,right or bottom of the worksheet.

Predict in Picklist
Attempt to find the contents of current cell in the picklist. This will slow down older computers.

Auto Complete
When selected, this will auto complete text in the cell as you type. The predictions are taken from
the current picklist.

Note:  Space or Backspace will cancel the currently predicted text.

Auto Select
Automatically select contents of a cell when the cursor first enters the cell. Default is on.

Cursor At End
This only applies when 'Auto Select' is off.

Template Protection
This option can be used to disable template protection.

Single Click Edit
When selected, 'edit mode' will start every time a cell is entered.
If not selected, 'edit mode' only starts when a cell is clicked twice, or 'Enter/Return' is pressed
while inacell. This is not a double-click , but simply a second click in the current cell.
Pressing 'Esc' will exit edit mode.

Confirm Overwrite when incrementing
Warn when using Fill and Inc, and ask to overwrite existing data.



default is on.

Replace Commas
Select a replacement for commas, if you don't want to allow them in your data.
You can select to allow, remove or replace commas with another character.

Replace Quotes
Select a replacement for double-quotes, if you don't want to allow them in your data.
You can select to allow, remove or replace double-quotes with another character.

Auto detect hyperlinks
Select this if you want to set the column hyperlink option automatically.
The detection is activated when you attempt to view a link or export html.
Ambiguous paths are not recognised as links.

Prefix ambiguous file paths
If this option is selected, and the column is set as hyperlink, then genscriber will attempt to fix
ambiguous file paths.
For example, myimage.jpg and C:/My Images/myimage.jpg may not be handle correctly by your
browser.
This option will add file:  to the beginning. i.e. file:  C:/My Images/myimage.jpg

Version 2.4 and higher
Charmap Button
Shows a button to open the system character map utility.

Strikeout Button
Show the strikeout/strikethrough button in the toolbar

CopyDown Button
Show the Copy Down button in the toolbar

IncDown Button
Show the Inc Down button in the toolbar

Enable Image Sync
Shows a button for opening the image sync editor.

Import-Export Preferences

Export Xml
This is a raw xml format.

Export FreeBMD
Allow export to the FreeBMD 'flat file' info header format.
This will be turned on automatically if a bmd file is opened.

Export GHF
Allow export to GHF files.
This will be turned on automatically if a ghf file is opened.

Export FreeREG
Allow export to the FreeREG info header format.
This will be turned on automatically if a frg file is opened.

Export FreeCEN
Allow export to the FreeCEN file' info header format.

Export with uno
Uno is a utility available in LibreOffice and OpenOffice. It allows us to Import/Export several
spreadsheet formats.
GenScriber makes use of uno to import and export extra file formats, including ods and xIs.

Show offsets when importing familysearch.org results
Each search results file downloaded from familysearch.org contains an offset. This is used to



identify the file in the set. This offset can be inserted into the top of the imported file.

Html Export

The html export is very useful for providing someone an easily readable version of your
worksheet.

The worksheet will be exported to one or more linked html files. A folder will be created during the
export process.

When exporting to html, each file will contain a maximum number of rows as per the setting of
'Html Rows Per Page'.

Each html file created will contain links to all other pages created from the worksheet.

Each link will be the number of the html file (page).

Html Rows Per Page
How many rows per page when exporting a worksheet to html.
The default is 200.

Set fixed widths
Sets fixed table and column widths when exporting html.

Set nowrap in
Stops text wrapping in cells when exporting html.

Use external css file
Exported html files use an external css file. Useful if you want to change the styles.
Note: The nowrap option above is not applied when using external css. You can set it in the css
file.

Add table sort
Option to add scripts to sort the table data.

Use UK (dd/mm/yy) format for shortdate
By default the tablesorter uses mm/dd/yy for shortdate. Selecting this option will force the use of
dd/mm/yy date format

Add a WebPage Heading
Select this if you want to add navigation etc at the top of the webpage. The html you add here will
be displayed in a div above the data tables.

Add a WebPage Footer
Select this if you want to add a footer to the webpage. The html you add here will be displayed in
a div below the data tables.

Both header and footer html will be added to every page created on export.

TextPad Preferences

The textpad specific options are mostly visual, and just show or hide buttons on the toolbar.

Enable File Tools
Show the Open, New and Save buttons.

Enable Search Tools
Show the search tool button

Enable Undo/Redo
Show the Undo/redo buttons

Enable Copy/Paste Tools



Show the Copy, Paste, Cut tool buttons

Show Hidden Chars
Show the special characters, such as newline etc.

No Page Breaks
Remove hidden page breaks from text.

Enable Ruler
Show the ruler and ruler tools

Pdf Export
Show the pdf export button

Html Export
Show the html export button

Print Tools
Show the print button

Toolbar Position
The textpad toolbar has only one button size, but it can be repositioned.
If you move the toolbar left or right when you have Font and Style tools selected it looks a bit ugly
due to the width required by font and style.

RichText Toolbar Options
These options simply turn on and off various buttons used for richtext editing, and should be
selected to your own preference.

If you prefer plain text instead of richtext, just turn off all richtext toolbar buttons and genscriber
will automatically disable richtext editing. File open and save will default to ".txt'

Global Settings

Global Preferences
The settings here affects all of genscriber.

Ctrl+Enter
In Worksheet:
Option full sync: Move to next row and sync image to current cell.
Option Inc: Move to next row and move image up (marker height)
Option New Image: Move to next row and open next image

In Notepad:
Option Inc: Move to next line and move image up (marker height)
Option New Image: Move to next line and open next image

Pdf Viewer (only available in Linux)
The name of the default pdf viewer. For example, atril or evince
This allows a cell to contain a link that will call a page within a pdf file.

Pdf Page Switch  (only available in Linux)
The switch (command) used by the pdf viewer to select a page when launched.
For example, atril uses' -p '

Tooltip Delay
sets the delay before tooltips are displayed.
A setting of '0' (zero) will disable tooltips.

Small Image Toolbar Buttons
Reduces the size of the image toolbar buttons.
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Image Toolbar Position
The image toolbar is always to the left of the image, but can be place top,left,right ot bottom of the
image file list.

Character Set
This will allow you to choose the character set for your system.
GenScriber uses the UTF-8 character set internally, and is able to display many different
languages correctly. Windows is deficient in this, and still uses the old code pages.
The purpose of choosing a character set is to tell GenScriber which character set your Windows
system is using.
When a file is saved, any extended characters will be converted to the correct code page for
Windows. When a file is opened, the file will be converted back to UTF-8.

Linux users will not have this problem. If you use Linux just leave the setting at UTF-8.

Set Language
Select the language you want to use. This option requires a restart of genscriber.
Some languages will require an external language file. See 'Language-Help' for more information.

Data Input Type
This sets the type of input(s) you want to have available. It can be either worksheet, textpad or
both. By default, genscriber uses both.

If you set this to just one type, and try to open a file belonging to the type not chosen, then
genscriber will attempt activate both types in order to open the file you selected.

Version 2.4 and higher
Use Alternative Layout
This selects the side-by-side layout.
It can also be changed during edit with  SHIFT+CTRL_F12

Image on left
Set the image on the left. If unselected, image goes to right.




Adding your own help files

Your own help files and instructions can be added to GenScriber very easily.
Any file placed in the 'help' folder will be displayed under the 'Help Menu'. The 'help' folder is
inside the 'GenScriber/include/' folder.

When one of the help menu entries is selected, GenScriber will attempt to display the
selected file using the system default application for that filetype. For example: to view pdf
help files, GenScriber will look for your default PDF reader.

Help files are usually PDF, TXT or, but files such as JPG,GIF,PNG may work too.

Version 2.4 and higher
Importing help files.
1. Choose' Import Help Files 'from the help menu.
2. Select the file to import.
The imported file will appear in the help menu.

Note: The web pages on genscriber.com have an option to save as PDF. These can be
imported.



Clipboard Filters

Special Paste Clipboard Filters

In GenScriber version 2.2, external clipboard filters were introduced.
There was a need to expand these filters. So, external clipboard filters were
introduced.

The purpose of these external filters is to filter and format data that has an unusual
layout. For example, the SSDI records from AmericanAncestors.org.

There are 2 internal filters. TABLE and RECORD, These filter will format standard
table and record formats found on web pages and spreadsheet apps etc.

DOWNLOAD HERE

Details about each filter and how to use them

TABLE Filter

The TABLE filter will paste from the clipboard multiple records formatted as
tabulated data.

The data can be taken from other applications (i.e. excel, openoffice etc.), or from
websites that display formatted records in tables.

' Smart Paste 'is on by default when pasting. This can be turned off during
pasting if required.

When Smart Paste is ON
The clipboard data must contain column titles in the first row.

Column order is not important. Column titles are compared to the existing
worksheet, and any columns with matching titles will be used. Other columns will
be discarded.

If' Create New Document 'is selected from the Paste dialogue, any column
titles found are automatically entered for you.

When Smart Paste is OFF
Data is pasted 'As Is'. Even if column titles do not match. This is useful for cases
where there are no column titles.

RECORD Filter

The RECORD filter will format a single list style record found on several websites.

Example record formatted as a list
FirstName: John

Surname: Hunt

BuriedBy: Joshua Brookes Chaplain
Relationship: son

MotherFirst:  Mary
MotherSurname:  Hunt

Source: LDS Film 2356998


https://genscriber.com/other_download/Filters/

Parish:  Manchester
Church: Cathedral
Register:  Burials 1792-1800

TABLE_FreeCEN

The TABLE_FreeCEN filter will correctly format data from FreeCEN search results.
1. Copy your search results table from the web page. (including table
tCIt:)er;S;.only the table. Take care not to copy any surrounding webpage items.

2 .Clickthe' Special Paste 'button.

3. Choose' TABLE_FreeCEN 'fromthe"' filter type ' pull down list. The
search results should now be correctly formatted in the preview table.

4. Click 'Paste' to add the records to your worksheet.

TABLE_FindMyPast

The TABLE_FindMyPast filter will correctly format data from FindMyPast search
results.

1. Copy your search results table from the web page. (including table
titles).
Copy only the table. Take care not to copy any surrounding webpage items.
2 .Clickthe' Special Paste 'button.

3. Choose' TABLE_FindMyPast 'fromthe' filter type 'pull down list.
The search results should now be correctly formatted in the preview table.

4. Click 'Paste' to add the records to your worksheet.

SSDI_LIST_AmericanAncestors

Filter for SSDl at americanAncestors.org

The SSDI search results at americanancestors.org require considerable editing
before they can be used in a spreadsheet. This filter will make it easy to copy/paste
SSDI data.

1. Copy your search results from the web page. Be sure to copy only the
table data.

2 .Clickthe' Special Paste 'button.

3. Choose' SSDI_LIST_AmericanAncestors 'fromthe' filter type '
pull down list. The search results should now be correctly formatted in the preview

table.

4. Click 'Paste' to add the records to your worksheet.



http://www.americanancestors.org/Search.aspx

SSDI_RECORD_GenealogyBank

The' SSDI_RECORD_GenealogyBank ' filter will format a single list style
record found on genealogybank.com Social Security Death Index (SSDI) Death
Record results.

1. Copy the record from the web page. Be sure to copy only the record data.
(Starting 'Name' ending 'Zip Code'.) Do not copy the big title above the record.

2 .Clickthe' Special Paste 'button.

3. Choose' SSDI_RECORD_GenealogyBank 'fromthe' filter type
pull down list. The search results should now be correctly formatted in the preview
table.

4. Click 'Paste' to add the records to your worksheet.

Example record from GenealogyBank

Name: John G. Hardy

State of Issue: Mississippi

Date of Birth: Monday August 17, 1908

Date of Death: Friday December 13, 2002

Est. Age at Death: 94 years, 3 months, 26 days

Confirmation: Verified

Last known residence:

City: Grenada; Dubard; Futheyville; Geeslin Corner; Hardy; Sunnycrest
County: Grenada

State: Mississippi

ZIP Code: 38901

Latitude: 33.8096

Longitude: -89.8042

Location of Last Benefit Paid:

City: Grenada; Dubard; Futheyville; Geeslin Corner; Hardy; Sunnycrest
County: Grenada

State: Mississippi

ZIP Code: 38901

SSDI_INDEX_GenealogyBank

The 'SSDI_INDEX_GenealogyBank' filter will correctly format data from
genealogybank.com/gbnk/ssdi/ search results.

1. Copy your search results table from the web page. (including table
titles).

Copy only the table. Take care not to copy any surrounding webpage items.

2 .Clickthe' Special Paste 'button.

3. Choose' SSDI_INDEX_GenealogyBank 'fromthe"' filter type 'pull
down list. The search results should now be correctly formatted in the preview
table.

4. Click 'Paste' to add the records to your worksheet.

Example GenealogyBank SSDI index

John G. Hardy


http://genealogybank.com/gbnk/ssdi/

Born: 1908 Died: 2002
State of last residence: Mississippi
State issued: Mississippi

Richard Hardy
Born: 1917 Died: 1984
State of last residence: Mississippi
State issued: Mississippi

Ida V. Hardy
Born: 1916 Died: 1995
State of last residence: West Virginia
State issued: West Virginia

Clipboard Filters How To (developer)

Special Paste Clipboard Filters.
There are two preset internal filters. TABLE and RECORD, These will filter
standard table and record formats found on web pages and spreadsheet apps etc.

There was a need to expand these filters without having to rebuild GenScriber
every time a new filter was needed. So, in version 2.2, external clipboard filters
were introduced.

The purpose of these external filters is to filter and format clipboard data that has
been copied from a web page. For example, the SSDI records from
AmericanAncestors.org.

When a working filter is selected from within genscriber, the data will be displayed
correctly in the preview grid. A wrong filter selection will usually just display nothing.

Developer Information
Filters can be programmed in any language capable of creating a command line
application that can be called from genscriber.

The external filter application will input the raw data from a file (filter.tmp), filter and
format it into a csv format, and set the first row as column titles. The data is then
written back to the ‘filter.tmp' file.

If the raw data is not suitable for the filter app, the "filter.tmp’ file is saved as empty
by the app.

Filter apps are stored in the folder ' /include/filters/

They may be written in any programming language that can be launched from the
command line.

No values are passed to the filter app, and none are returned.

The filenames of the filter apps are used in the 'Special Paste' dropdown filter list,
so filenames should be explanatory and must be a reasonable length.

After a filter has run, if the "filter.tmp’ file contains data (> 10 characters), it is
assumed that the filtering was successful.

The filter app will do the following...

1. Open and read the raw data from 'filter.tmp".

2. If data is missing or not suitable for this filter, then save empty ‘filter.tmp' and
exit.

3. Parse and filter the data as needed.

4. Format as csv (comma separated values, with first row as column titles)

5. Save formatted data to ‘filter.tmp' and exit.



An example vb app

Dim sBuf As String

Dim sTenpln As String
Dim sTenpQut As String
DimiFil eNum As | nt eger
Dim sFil eNane As String
sFileName = "filter.tnp"

‘open the "filter.tnp' file
i Fl leNum = FreeFile
Open sFil eName For Input As iFileNum
‘" read in the data
Do Until EOF(iFileNum
Li ne I nput #i FileNum sBuf
sTenpln = sTenpln & sBuf & vbCrlLf
Loop
Close iFileNum

"your filter code goes here...
"filter the sTenpln >> sTenpCQut
"format it as csv

'Now save formatted data...

iFileNum = FreeFile

Open sFil eNane For Qutput As iFileNum
Print #i FileNum sTenpCQut

Cl ose i Fil eNum

Clipboard Filters How to (user)

Special Paste Clipboard Filters.
There are two preset internal filters. TABLE and RECORD, These will filter
standard table and record formats found on web pages and spreadsheet apps etc.

There was a need to expand these filters without having to rebuild GenScriber
every time a new filter was needed. So, in version 2.2, external clipboard filters
were introduced.

The purpose of these external filters is to filter and format clipboard data that has
been copied from a web page. For example, the SSDI records from
AmericanAncestors.org.

When a working filter is selected from within genscriber, the data will be displayed
correctly in the preview grid. A wrong filter selection will usually just display nothing.

User Information
1. Select and copy the data from the web page as required by the filter you are
using.

2. Click the ' Special Paste ' button.

3. Select the filter type from the drop down list. The formatted data should display in
the preview grid.

4. Click the ' Paste 'button to paste into the worksheet. If a document is not
already open, you will usually needto' Create new Document ' before pasting.




Column Options Toolbar

X9~ @

This is the column options toolbar.

il

Show advanced options

Turn template protection on/off

Show all columns

Reset options to defaults

Help



How to type special characters

Western european special characters and how to enter them from your
keyboard in Windows.

To type a special character

1. Make sure the numeric key pad on the right of the keyboard is active by
pressing Num Lock (upper right of keyboard).
The Num Lock light on the keyboard will indicate that the numeric key pad is
on.

NOTE: You must use the numeric key pad; if you use the number keys on the
top of the keyboard, the characters will not appear.

If you are on a laptop or computer without a separate numeric keypad use the
character map app instead.

2. Place your cursor in the location where you wish to insert a special
character.

3. While holding down the ALT key, type the four-digit code on the
numeric key pad.

NOTE: If you have the International keyboard activated, you will only be
able to input codes using the ALT key on the left side of the keyboard.

4. Release the ALT key, and the character will appear.
NOTE: You must include the initial zero in the code. For example to insert
a (0225) you must type 0225, NOT 225.

This table applies only to Windows

t 0134 dagger

T 0135 double dagger

™ 0153 trademark sign

¢ 0162 cent sign

o 0164 general currency sign
¥ 0165 yen sign

§ 0167 section sign

© 0169 copyright

® 0174 registered trademark
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Ya

Ya

Y

> > >
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0176

0177

0181

0182

0183

0188

0189

0190

0191

0192

0193

0194

0195

0196

0197

0198

0199

0200

0201

0202

0203

0204

0205

0206

0207

0208

degree sign

plus or minus

micro sign

paragraph sign

middle dot

one-fourth

one-half

three-fourths

inverted question mark
uppercase A, grave accent
uppercase A, acute accent
uppercase A, circumflex accent
uppercase A, tilde

uppercase A, umlaut
uppercase A, ring

uppercase AE

uppercase C, cedilla
uppercase E, grave accent
uppercase E, acute accent
uppercase E, circumflex accent
uppercase E, umlaut
uppercase |, grave accent
uppercase |, acute accent
uppercase I, circumflex accent
uppercase |, umlaut

uppercase Eth, Icelandic
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(et}

(@)

0209

0210

0211

0212

0213

0214

0216

0217

0218

0219

0220

0221

0222

0223

0224

0225

0226

0227

0228

0229

0230

0231

0232

0233

0234

0235

uppercase N, tilde

uppercase O, grave accent
uppercase O, acute accent
uppercase O, circumflex accent
uppercase O, tilde

uppercase O, umlaut
uppercase O, slash

uppercase U, grave accent
uppercase U, acute accent
uppercase U, circumflex accent
uppercase U, umlaut
uppercase Y, acute accent
uppercase THORN, Icelandic
lowercase sharps, German
lowercase a, grave accent
lowercase a, acute accent
lowercase a, circumflex accent
lowercase a, tilde

lowercase a, umlaut
lowercase a, ring

lowercase ae

lowercase c, cedilla

lowercase e, grave accent
lowercase e, acute accent
lowercase e, circumflex accent

lowercase e, umlaut



0236

0237

0238

0239

0240

0241

0242

0243

0244

0245

0246

0247

0248

0249

0250

0251

0252

0253

0254

0255

lowercase i, grave accent
lowercase i, acute accent
lowercase i, circumflex accent
lowercase i, umlaut

lowercase eth, Icelandic
lowercase n, tilde

lowercase o, grave accent
lowercase o, acute accent
lowercase o, circumflex accent
lowercase o, tilde

lowercase o, umlaut

division sign

lowercase o, slash

lowercase u, grave accent
lowercase u, acute accent
lowercase u, circumflex accent
lowercase u, umlaut
lowercase y, acute accent
lowercase thorn, Icelandic

lowercase y, umlaut



Importing and Exporting

GenScriber will import and export several different formats. Some formats
are handled by GenScriber, other formats require the UNO app found in
Libre Office and Open Office.

Imported files are always converted to csv files. These are utf-8 by
default. If a different character set is chosen in “Preferences” the import
export will attempt to convert from the selected code page.

The exception to this is Gedcom. Exported gedcom files are always UTF-
8.

When importing gedcoms, the file header is used to determine the
character set used in the file.
GenScriber will import Ansel, UTF-8, ASCIlI and ANSI .

ANSI is not actually allowed in gedcoms, but it is sometimes used and
when it is used, it needs to be handled differently.

If the character set in preferences is utf-8, then the windows-1251
codepage will be used.

If a character set other that utf-8 has been chosen in preferences, then
that codepage will be used instead.

Merging files

File Merge.
Multiple files can be opened and merged automatically. You can Import
and Merge at the same time.
File types are allowed to be different, but all merged files must use the
same template layout (identical column titles in the same order).
How to select multiple files to open/merge.
Wheninthe' Open File 'dialog, hold downthe" Ctrl' or
'Shift'  key to select multiple files.
Files will be opened and concatenated in the order found on disk.

The name of the first file opened will be used as the filename, with -new'
appended.

The resulting file will be CSV format.

example filel.xls +file2.0ds +file3.csv = filel-new.csv

Setting up uno import export

Setting up import/export using unoconv.

GenScriber 2.1.5 and above will import and export several extra file
formats, including ods and xIs.



The 'Export with uno' option must be selected in '
Tools>Preferences>Export

Important:  For this to work, you must have either LibreOffice or
OpenOffice installed on your system.
On Linux systems this is not a problem, either LibreOffice or OpenOffice
is usually installed by default, and it should work out of the box.

Windows users will need to install LibreOffice (or OpenOffice) manually. If
you don't already have it, you can download it here...
http://www.libreoffice.org

Below is a check list to help make the export functions work for
you.
. Install LibreOffice or OpenOffice (version 3 or above) .
. Start GenScriber.
. Go to Tools>Preferences>Export'.
. Check the 'Export with uno' option is selected.
. Check that there is a path entry to python.exe.
. If no path, click on 'search’ and wait until the path appears.
. Close Preferences.
If all of the above is ok, you will be able to open and export several
different
spreadsheet formats.

OO~ WNE

If the import/export functions don't work for you.

Windows 7 and 8 users.
Win 7/8 blocks almost any file it does not own. That is just about every file
you introduce into your system. Unless you have already turned this off,
there is a good chance that the genscriber support files will be blocked.
If things don't work as expected, this is probably your problem.

Windows needs to know where to find python.exe. This will usually be

something like

“C:/Program Files/LibreOffice 4/program/python.exe”.

When 'Preferences' is opened, genscriber will attempt to find the

correct path and add it for you. The path will be displayed in
'Tools>Preferences>Export>Path to python' . If you see a path

here you probably don't need to change it.

If the path is empty, then you need to tell GenScriber to search for
python.exe.

Whenin  Tools>Preferences>Export clickonthe' search
button ( to the right of the path box ). GenScriber will carry out a deep
search and add the path for you.

The GHF file format

The GHF Header
The GHF header is a simple and reliable way to add extra information to
csv files. It is placed at the top of a normal CSV file, above the title row.
Unlike some info headers, ghf is compatible with spreadsheets.

The GHF header uses open and close tags <INFO> and
</INFO>
This allows parsing applications to easily extract the information.

The <INFO> tag starts the header, and is placed in the first column of the
first row.


http://www.libreoffice.org/

The first column of rows following the <INFO> tag may contain the
information items.

Info items can contain anything except commas and quotes.

A maximum of 10 info items(rows) may be place between the tags.

Tags and info items are  always in the first column . Other columns
are ignored.

The header is then closed with the </INFO> tag. This must also be in the
first column.

Column Titles must be on the row immediately after the closing tag.

Example header:

<INFO> ,,,111001s
Church: St. josephs,,,, 1111,
Pansh CharleStOWn”””””, Source: Pa”Sh I‘eCOI’dS (original)nnnl”n

Transcriber: Les Hardy,,,,,,, .,

Email: les@webmayo.com,,,,,,,,,,,
</[INFO> ,,..\1ies
Surname,FirstName,Day,Month,Year,Abode,County,Aged,Rela,Status,Extra,Occupation

Note: the extra commas match the title row, and are there to ensure
compatibilty with spreadsheet applications.

Adding The GHF Info Header
The header information you enter into the header info fields will be added
automatically to the worksheet when exported as GHF.Use the ".ghf ' file
suffix for GHF files.

The Information
Ten fields are available.
Any information you enter here refers to the current worksheet, and if the
worksheet is exported as .ghf, it will be saved in the file header.

When a new file is opened, all previous header info fields will be cleared.
If a .ghf file is opened, any header info it contains will be shown in the
header information.

If you save as .csv, the header information will NOT be saved into the csv
file, but the information fields will remain until the file is closed.

Field Titles
You can add/edit the field titles by simply placing your mouse cursor in the
grey area above a field, and left-click once, then type in the field title.
Field titles are retained when you quit genscriber, and will remain until you
change them.

FreeCEN format

Worksheets can be saved with the FreeCEN file format'.
If this menu option is unavailable, goto' Tools/Preferences
under the' Export 'tabselect' Export FreeCEN '

and

The Header Information
The FreeCEN header information will be included in the header of files
exported as 'FreeCEN'
The FreeCEN file is saved witha' .cen 'suffix.

You will need to change the file suffix to '.csv' before sending it to your



coordinator.

Census Piece: This is the census piece being transcribed. example:
RG121780

Registration District Number:  The registration district number you
are working on.

Transcriber Code:  Enter your transcriber code here.

Transcriber Name:  Enter your name here. (optional)

Each time a FreeCEN (.cen) file is opened, the header information is
retrieved (if it exists).

When a FreeCEN (.cen) file is exported, the current header information is
saved in the file.

It is quite acceptable to open a csv file, edit the FreeCEN header info, and
then export as FreeCEN.

FreeBMD Format

Worksheets can be opened and saved with the FreeBMD 'flat file header'.

The following explanation was created from information found on the
FreeBMD website...

The “Flat” file format is designed to cater for datasets stored in a database
or spreadsheet with all data for each entry on a single line (hence the
name “flat”).

The essence of the flat format is this, so long as all required data is
available, it can be submitted in almost any layout. A line at the top of the
file defines what goes where.

Example of Flat File Format
+INFO,jverge@assendon.demon.co.uk,pw,ONENAME,BIRTHS ,UTF-8
+FORMAT,Surname,Firstname,District,Volume,Page,Quarter,Year,Type
VERGE,John,Ringwood,VIIl,205,Mar,1838,B
VERGE,George,Ringwood, VI11,198,Jun,1841,B
VERGE,Mary,Fordingbridge,VIIl,181,Mar,1843,B
VERGE,Joseph,London,I1,177,Sep,1843,B

Column types
Each column type may have alternate names, which are shown in
brackets after the standard name.

Surname  The surname of the subject of the entry.

FirstNames (FirstName,Forename) The first names of the subject of
the entry.

OtherName optional. If present, this is appended to the firsthames
field.

District  The district in which the event was registered.

Volume The volume number in which the event appears.

Page The page number of the event.

Quarter  The quarter of the entry (i.e. Mar, Jun, Sep ). You can use
QuarterNumber instead.

QuarterNumber is the number of the quarter of the entry (in the
range 1-4, 1 is Mar and so on).

Year The year of the entry.

Type (Event) optional The event type - one of: BIRTH, MARRIAGE,
DEATH.

N.B. Event types cannot be mixed in a single file. This field is
therefore only useful as a crosscheck.



Additional Optional Columns

AgeAtDeath optional The age at death (death events only, of
course).

DateOfBirth  optional The date of birth (death events only, replaces
AgeAtDeath from 1969).

Mother optional Mother's (maiden) name (birth events only).

Spouse optional Spouse's surname (marriage events only).

FicheRange optional The range of surnames covered by the fiche
this entry was on.

FicheNumber optional The number of the fiche this entry was on.

Adding The Info Header
The info header is added automatically to any worksheets exported as
FreeBmd.
Use the .bmd file suffix for your FreeBMD files.

Editing The Info Header Details
To edit the info header, select’ Tools' > 'View/Edit Info Headers' >
'FreeBMD Info .
If this menu option is unavailable, goto' Tools/Preferences
under the' Export 'tabselect' Export FreeBMD .

and

The FreeBMD header Information

Email : This is the email address of the transcriber (optional ).

Sequenced :is one of SEQUENCED, RANDOM or ONENAME.

SEQUENCED : Should be used to transcribe complete pages from
the index.

RANDOM : Should be used to transcribe entries that are not related
to the location in the index page.

ONENAME : Should be used to transcribe sections of pages that
relate to a single name.

RecordType :BIRTHS, MARRIAGES, or DEATHS.

CharacterSet : The characters set you are using. (This is entered for

you ).

Each time a FreeBMD (.bmd) file is opened, the header information is
retrieved (if it exists).

When a FreeBMD (.bmd) file is exported, the current header information
is saved in the file.

It is quite acceptable to open a csv file, edit the FreeBMD header info, and
then export as FreeBMD.

FreeREG Header Information

This is the “Header” information that will be included in the header of files
exported as FreeREG. This is required by FreeREG to enable them to
understand the data and who provided it.

Submitter Email e-mail address of the submitter.

Password  Your password (it may be required in the future). At the
present time simply use password for this field.

Record Type The type of register information being submitted. It can
be BAPTISMS, MARRIAGES or BURIALS.

CharSet The character set to export as
Submitter Name  The name of the person submitting the file.
Submitter County  The group with which the submitter is working.



Transcribe Filename
The file name must consist of:
a three letter Chapman code for the county
a three letter placename code assigned by the person uploading the file
BA|BU|MA][part number, if any

Transcribe Date  The date of transcription (dd-mon-yyyy)

Credit Name Enter the transcriber name. This is used to provide
credit information for others involved in the transcription of the file.

Credit Email  The transcriber e-mail address. This is used to provide
credit information for others involved in the transcription of the file.

Modification Date  The date this file was modified.

Commentl Itis suggested that this is used to detail the source of the
data.

Comment2 Use this for any copyright restrictions, or any comments
you wish to make about the file.

Add +LDS  Select this if two extra fields for Film and Image number
have been added to every data record.

The FreeREG header information will be included in the header of files
exported as 'FreeREG' . The FreeREG file is saved with a ".frg" suffix.

You will need to change the file suffix to '.csv' before sending it to your
coordinator.

Exporting to Xml (raw)

The Xml raw export creates a clean xml file that can be used by any
application capable of reading xml. This includes your web browser.

How to export to xml

1. Fromthe 'File 'menu, choose' Export>Xml (raw)

2. Choose the filename to use for the xml file.( default is the current
filename + .xml)

3. Click the 'Open’ button.

Gedcom Import

Importing a gedcom file.

1. Select' Open Document 'fromthe' File Menu 'or click on
the open button in the worksheet toolbar.

2. Fromthe' Open ‘'dialog' Type 'dropdown list, select'
IMPORT Gedcom .

3. Select the gedcom file, and click' Open

Columns not used by the imported gedcom file are hidden in the
worksheet. These can be made visible viathe' Column Control 'if
needed.

When embedded notes are encountered during import, they are saved to
text files. A folder is created with the name of the gedcom file, appended



with' _files . Links to these text files are placed in the notes column.

To view a notes file, right click on a cell in the * Notes ' column and
choose ' View this link .

To edit a notes files, when in edit mode, right click and choose ' Edit
note

Gedcom Export

Exporting a gedcom file.

1. Open the "**File**'" menu and choose '**Export**' and then '**Gedconmr*'.
2. Select the path and fil enane.
3. Cick '**Save**'

Any “notes” files will be embedded into the gedcom file during export.

Not all worksheets can be saved as a gedcom file. The gedcom file will
contain information about individuals, and the worksheet needs to have
the correct information for it to be of any use as a gedcom.

The minimum column titles that genscriber will accept for a gedcom
export, are  Person_Ild *,  Surname, Given_Name, Sex

The columns you want to export must have one of the titles that
genscriber will recognise as a gedcom field.

The worksheet may contain other titles, but they will not be exported.

Note *: The Person_ID can be created automatically during export.

The table below lists column titles that are recognised as gedcom fields.
The titles are not case sensitive and may contain spaces or underscores
anywhere in the title. You can use any of these column titles in any order.
| have tried to add enough variation in the names to avoid making it to
restrictive. If I have missed a commonly used name, please contact me.

GEDCOM_TAG ACCEPTABLE COLUMNS TITLES

INDI INDI, Individual, ID, Person, Personld
SURN SURN, Surname, Lastname
GIVN GIVN, Given, GivenName, Givennames, FirstName,

FirstNames, Forename, Forenames

SEX SEX, Gender



BIRT (DATE)

BIRT (PLAC)

BIRT SOUR)

BAPT (DATE)

BAPT (PLAC)

BAPT (SOUR)

DEAT (DATE)

DEAT (PLAC)

DEAT (SOUR)

BURI (DATE)

BURI (PLAC)

BURI (SOUR)

OBJE (FILE)

Ooccu

SOUR

NOTE

Father ID

Mother ID

BIRT, Birth, Born, DateBorn, BirthDate

BirthPlace, PlaceBorn

BirthSource

BAPT, Baptism, BaptDate, BaptismDate

BaptPlace, BaptismPlace

BaptSource, BaptismSource

DEAT, Death, DeathDate

DeathPlace

DeathSource

BURI, Burial, BurialDate

BurialPlace

BuriSource, BurialSource

Image, Photo, ImagePath, PhotoPath, MediaPath,
ImageFilePath, PhotoFilePath, MediaFilePath,

ImageLink, Media, MediaLink, PhotoLink

OCCU , Occupation

SOUR, Source

NOTE, Notes

Father , FatherID

Mother, MotherID



Spouse ID 1

MARR (DATE)

MARR (PLAC)

MARR (SOUR)

MARR (STAT)

Spouse ID 2

MARR (DATE)

MARR (PLAC)

MARR (SOUR)

MARR (STAT)

Spouse Id 3

MARR (DATE)

MARR (PLAC)

MARR (SOUR)

MARR (STAT)

Spouse Id 4

MARR (DATE)

MARR (PLAC)

Spouse , SpouselD

Married , Marriage, MarriedDate , MarriageDate

MarriedPlace , MarriagePlace

MarriedSource , MarriageSource

MarriedStatus , MarriageStatus, MarrStat,

MarriageStat

Spouse?2 , SpouselD2

Married2 , Marriage2, MarriedDate2 , MarriageDate2

MarriedPlace2 , MarriagePlace2

MarriedSource2 , MarriageSource2

MarriedStatus2 , MarriageStatus2, MarrStat2,

MarriageStat2

Spouse3 , SpouselD3

Married3 , Marriage3, MarriedDate3 , MarriageDate3

MarriedPlace3 , MarriagePlace3

MarriedSource3 , MarriageSource3

MarriedStatus3 , MarriageStatus3, MarrStat3,

MarriageStat3

Spouse4 , SpouselD4

Married4 , Marriage4, MarriedDate4 , MarriageDate4

MarriedPlace4 , MarriagePlace4



MARR (SOUR) MarriedSource4 , MarriageSource4

MarriedStatus4 , MarriageStatus4, MarrStat4,

MARR (STAT)  MarriageStata

CENS (DATE)  CENS, Census, CensDate, CensusDate
CENS (PLAC) CensPlace, CensusPlace

CensAddress, CensAddr, CensusAddr,
CensusAddress

CENS (ADDR)
CENS (AGE) CensAge, CensusAge

CensRela, CensusRela, RelationshipToHead,

CENS (RELA) Relationship, CensRelationship, CensusRelationship

CENS (NOTE)  CensNote

Pdf Export

Worksheet PDF Export.
Exporting large worksheets to pdf can be a problem. If the exported pdf
pages are kept at A4 size, a large worksheet is either unreadable, or it
has to be spread it over multiple pages.

| decided to make the pdf export resize the pages to fit the worksheet.
This creates non-standard pages, but allows scrolling to view large
worksheets. The only problem is if you want to print it, but | will leave that
for you to ponder over.

Only visible fields are exported. Hiding fields is one way of reducing the
width of the exported pages.

TextPad PDF Export
The textpad does not have any problems like the above.

Exporting Html

Html Export
This is one of my favourite features.The html export is very useful for
providing someone with an easily readable version of your worksheet or
even creating webpages.
The html files produced by genscriber are compliant with  W3C
standards and are suitable for use on the Internet.
I only cover the basics here. If you need to know more, please contact me
and | will provide detailed instructions.



How to export to html
1. Set the html options in 'preferences'.

2. If there are columns you do not want to export, hide them.

3. If the 'Set fixed width' option is chosen, adjust the worksheet column
widths to suit.

4. From the 'File' menu, choose 'Export > Html Files'.

5. Choose the basename to use for the html files.( default is the current
filename )

6. Click the 'Open’ button.

A folder with the name of your base filename choice will be created
automatically, and the exported html files will be place in this folder.

If you chose to have column sorting, then a folder called ‘tablesorter' will
be created in the html export folder. This contains the jquery library and
scripts.

Html Export options in Tools>Preferences

Html| Rows Per Page
Each file will contain a maximum number of rows as per the setting of
'Html Rows Per Page'. The default is 200.
Each html file created will contain links to all other pages. The link will be
the number of the html file (page).

Set fixed <column> widths
Sets fixed table and column widths when exporting html.
When this option is selected, the html column widths will be fixed
according to the widths of the columns in the worksheet at the time of
export.

If nowrap is also set, columns will expand to accomodate data.

Set nowrap in <td>
Stops text wrapping in cells when exporting html.
This is best set ON when 'Set fixed' above is OFF.

Use external css file
Instructs genscriber to create an external css file when exporting. Useful if
you want to change the styles in one place.

Add table sort
Option to add scripts to sort the table data.

Use dd/mm/yy format for shortdate
The date format for shortDate is 'mm/dd/yy ' by default. To change to
‘dd/mmlyy ', select this option.

Add a webpage heading
This will add html above the exported tables. It will be added to every web
page.
When you select this option, the 'Heading Html' below becomes active.

Heading Html
Add the html for your heading here, or if you prefer, edit the 'header.html’
file directly.
The header.html file can be found in the ‘/include/web/' folder. | have
added example html for navigation. Modify or delete this as you like.



Add a webpage footer
This will add html below the exported tables. It will be added to every web
page.
When you select this option, the 'Footer Html' below becomes active.

Footer Html
Add the html for your footer here, or if you prefer, edit the ‘footer.html’ file
directly. The footer.html file can be found in the ‘/include/web/' folder.

Location of html template files
The html template files can be found in the '
GenScriber/include/web/ ' folder.

header.html
This is the header. Modify this as you like. It is displayed in a div above
the tables.

footer.html
This is the footer. Modify this as you like. It is displayed in a div below the
tables.

tablestyle.css
This is the css file. Modify this to change the style of your web pages.

tablesorter
The folder contains the files that are included when you choose to have
table sorting. The css file for tablesorter is located in this folder.

Special placeholders
There are a few placeholder that can be used in the header and footer
templates.
{YEAR} This will be replace by the current year.
{FILETITLE} The name of the worksheet file.
{USERNAME} Your username used by the system.

I can add more of these later if they prove to be useful.

About the css files
The internal and external css are both derived from a file in the
'include/web’ folder called 'tablestyle.css'. If you want to change the css,
edit this file before you export.

You can of course change the css file in the exported html folder at any
time, but keep in mind that if you export again to the same folder, the css
file in the exported html folder will be overwritten by the one from the
include folder.

There is also a css file in the 'tablesorter folder' (
include/web/tablesorter/tablesorter.css ). This file is specific to the
tablesorter headers.

About the table sort files
The table sort files are stored in the ‘tablesorter' folder, as follows...

asc.gif image used in the thead for sorted ascending.
dec.gif  image used in the thead for sorted decending.
bg.gif image used in the thead for unsorted.

jquery.js  jQuery JavaScript Library v1.4.2.
tablesorter.js  TableSorter 2.0 javascript.
tablesorter.css TableSorter CSS

If the 'table sort' option is selected, these files will be copied to the html



export folder, and javascript code is written to the exported html files.

During export, genscriber will scan all cells of the first 1000 records to

determine the type of data.

The sort type will be set for the content found. If mixed data is found, the

sort type will be set by majority.

May 23 1890
23 May 1890
1890/5/23
1890-5-23

Monday, June 15, 2009 1:45 PM
May 23 1890 23

05/23/1890 or 05-23-1890

shortDate is mm/dd/yy by default.

add {dateFormat: “dd/mm/yy”} to change to
uk dates.

123.123.123.123

07:25am
07:25pm

The date format for shortDate is' mm/dd/yy

isoDate

usLongDate

shortDate

ipAddress

time

' by default.

Tochangeto' dd/mmlyy ', selectthe option in'Html Settings', or
include the following code into the javascript of each html page.
$(“#gstables”).tablesorter({dateFormat: “dd/mm/yy”});




Language Support

GenScriber supports many different languages by the use of

language translation files.

The language files are stored in the
GenScriber/include/language ' folder.

There is a translation editor available that simplifies the process of
creating language files.

It allows creation of new language files, or editing existing language
files.

If you create a translation for your language please consider sending
it to me, so that | can add it to genscriber.

Language Files
The use of language files allows GenScriber to be easily translated to
other languages.

When you select a language in GenScriber, a new language file is
created (if it doesn't already exist). This language file may already
contain some translations, but there will probably be some phrases
still not translated.

Any changes made to the language file will appear in GenScriber
when you next start it.

Language files are stored in the ' GenScriber/include/language
folder.

The filename format of a language filename is always “
LANGUAGE-COUNTRY.UTF-8.tr “

Example: EN- GB .UTF-8.tr = English-Great Britain
ES-ES.UTF-8.tr = Spanish-Spain

The Language-Country code and Character set must always be
uppercase.
The suffix (.tr) must always be lowercase.

Language Translation Editor

The translation editor simplifies the process of creating language
files.
It allows creation of new language files, or editing existing language
files.

Click here to read more...

List of language and country codes

Lang - Country Country - language
prs-AF Afghanistan - Dari
ps-AF Afghanistan - Pashto
sq-AL Albania - Albanian


http://www.genscriber.com/genapps/genscriber/help/language_translation_editor

ar-DZ Algeria - Arabic

tzm-DZ Algeria - Tamazight (Latin)
es-AR Argentina - Spanish

hy-AM Armenia - Armenian

en-AU Australia - English

de-AT Austria - German

az-AZ Azerbaijan - Azeri (Cyrillic)
az-AZ Azerbaijan - Azeri (Latin)
ar-BH Bahrain - Arabic

bn-BD Bangladesh - Bengali

be-BY Belarus - Belarusian

nl-BE Belgium - Dutch

fr-BE Belgium - French

en-BZ Belize - English

es-VE Bolivarian Republic of Venezuela - Spanish
quz-BO Bolivia - Quechua

es-BO Bolivia - Spanish

bs-BA Bosnia and Herzegovina - Bosnian (Cyrillic)
bs-BA Bosnia and Herzegovina - Bosnian (Latin)
hr-BA Bosnia and Herzegovina - Croatian
sr-BA Bosnia and Herzegovina - Serbian (Cyrillic)
sr-BA Bosnia and Herzegovina - Serbian (Latin)
pt-BR Brazil - Portuguese

ms-BN Brunei Darussalam - Malay
bg-BG Bulgaria - Bulgarian

km-KH Cambodia - Khmer

en-CA Canada - English

fr-CA Canada - French

iu-CA Canada - Inuktitut (Latin)

iu-CA Canada - Inuktitut (Syllabics)
moh-CA Canada - Mohawk

en-029 Caribbean - English

arn-CL Chile - Mapudungun

es-CL Chile - Spanish

es-CO Colombia - Spanish

es-CR Costa Rica - Spanish

hr-HR Croatia - Croatian

cs-CZ Czech Republic - Czech
da-DK Denmark - Danish

es-DO Dominican Republic - Spanish
quz-EC Ecuador - Quechua

es-EC Ecuador - Spanish

ar-EG Egypt - Arabic

es-SV El Salvador - Spanish

et-EE Estonia - Estonian

am-ET Ethiopia - Amharic

fo-FO Faroe Islands - Faroese

fi-FI Finland - Finnish

smn-FI Finland - Sami (Inari)

se-FI Finland - Sami (Northern)
sms-FI Finland - Sami (Skolt)

sv-FI Finland - Swedish

gsw-FR France - Alsatian

br-FR France - Breton

co-FR France - Corsican

fr-FR France - French

oc-FR France - Occitan

ka-GE Georgia - Georgian

de-DE Germany - German

dsb-DE Germany - Lower Sorbian
hsb-DE Germany - Upper Sorbian
el-GR Greece - Greek

kl-GL Greenland - Greenlandic



qut-GT Guatemala - K'iche

es-GT Guatemala - Spanish

es-HN Honduras - Spanish

zh-HK Hong Kong S.A.R. - Chinese (Traditional) Legacy
hu-HU Hungary - Hungarian

is-1S Iceland - Icelandic

as-IN India - Assamese

bn-IN India - Bengali

en-IN India - English

gu-IN India - Guijarati

hi-IN India - Hindi

kn-IN India - Kannada

kok-IN India - Konkani

ml-IN India - Malayalam

mr-IN India - Marathi

or-IN India - Oriya

pa-IN India - Punjabi

sa-IN India - Sanskrit

ta-IN India - Tamil

te-IN India - Telugu

id-ID Indonesia - Indonesian

fa-IR Iran - Persian

ar-1Q Iraq - Arabic

en- IE Ireland - English

ga- IE lIreland - Irish

ur-PK Islamic Republic of Pakistan - Urdu
he-IL Israel - Hebrew

it-IT Italy - Italian

en-JM Jamaica - English

ja-JP Japan - Japanese

ar-JO Jordan - Arabic

kk-KZ Kazakhstan - Kazakh

sw-KE Kenya - Kiswahili

ko-KR Korea - Korean

ar-KW Kuwait - Arabic

ky-KG Kyrgyzstan - Kyrgyz

lo-LA Lao P.D.R. - Lao

Iv-LV Latvia - Latvian

ar-LB Lebanon - Arabic

ar-LY Libya - Arabic

de-LI Liechtenstein - German

[t-LT Lithuania - Lithuanian

fr-LU Luxembourg - French

de-LU Luxembourg - German

Ib-LU Luxembourg - Luxembourgish
zh-MO Macao S.A.R. - Chinese (Traditional) Legacy
mk-MK Macedonia (FYROM) - Macedonian (FYROM)
en-MY Malaysia - English

ms-MY Malaysia - Malay

dv-MV Maldives - Divehi

mt-MT Malta - Maltese

es-MX Mexico - Spanish

mn-MN Mongolia - Mongolian (Cyrillic)
sr-ME Montenegro - Serbian (Cyrillic)
sr-ME Montenegro - Serbian (Latin)
ar-MA Morocco - Arabic

ne-NP Nepal - Nepali

nl-NL Netherlands - Dutch

fy-NL Netherlands - Frisian

en-NZ New Zealand - English
mi-NZ New Zealand - Maori

es-NI Nicaragua - Spanish

ha-NG Nigeria - Hausa (Latin)



ig-NG Nigeria - Igho

yo-NG Nigeria - Yoruba

nb-NO Norway - Norwegian (Bokmal)
nn-NO Norway - Norwegian (Nynorsk)
smj-NO Norway - Sami (Lule)

se-NO Norway - Sami (Northern)

sma-NO Norway - Sami (Southern)

ar-OM Oman - Arabic

es-PA Panama - Spanish

es-PY Paraguay - Spanish

zh-CN People's Republic of China - Chinese (Simplified) Legacy
mn-CN People's Republic of China - Mongolian (Traditional
Mongolian)

bo-CN People's Republic of China - Tibetan
ug-CN People's Republic of China - Uyghur
ii-CN People's Republic of China - Yi
quz-PE Peru - Quechua

es-PE Peru - Spanish

fil-PH Philippines - Filipino

pl-PL Poland - Polish

pt-PT Portugal - Portuguese

fr-MC Principality of Monaco - French
es-PR Puerto Rico - Spanish

ar-QA Qatar - Arabic

en-PH Republic of the Philippines - English
ro-RO Romania - Romanian

ba-RU Russia - Bashkir

ru-RU Russia - Russian

tt-RU Russia - Tatar

sah-RU Russia - Yakut

rw-RW Rwanda - Kinyarwanda

ar-SA Saudi Arabia - Arabic

wo-SN Senegal - Wolof

sr-RS Serbia - Serbian (Cyrillic)

sr-RS Serbia - Serbian (Latin)

sr-CS Serbia and Montenegro (Former) - Serbian (Cyrillic)
sr-CS Serbia and Montenegro (Former) - Serbian (Latin)
zh-SG Singapore - Chinese (Simplified) Legacy
en-SG Singapore - English

sk-SK Slovakia - Slovak

sl-SI Slovenia - Slovenian

af-ZA South Africa - Afrikaans

en-ZA South Africa - English

xh-ZA South Africa - isiXhosa

zu-ZA South Africa - isiZulu

nso-ZA South Africa - Sesotho sa Leboa
tn-ZA South Africa - Setswana

eu-ES Spain - Basque

ca-ES Spain - Catalan

gl-ES Spain - Galician

es-ES Spain - Spanish

si-LK Sri Lanka - Sinhala

smj-SE Sweden - Sami (Lule)

se-SE Sweden - Sami (Northern)

sma-SE Sweden - Sami (Southern)

sv-SE Sweden - Swedish

fr-CH Switzerland - French

de-CH Switzerland - German

it-CH Switzerland - Italian

rm-CH Switzerland - Romansh

ar-SY Syria - Arabic

syr-SY Syria - Syriac

zh-TW Taiwan - Chinese (Traditional) Legacy



tg-TJ Tajikistan - Tajik (Cyrillic)

th-TH Thailand - Thai

en-TT Trinidad and Tobago - English
ar-TN Tunisia - Arabic

tr-TR Turkey - Turkish

tk-TM Turkmenistan - Turkmen
ar-AE U.A.E. - Arabic

uk-UA Ukraine - Ukrainian

en- GB United Kingdom - English
gd- GB United Kingdom - Scottish Gaelic
cy- GB United Kingdom - Welsh
en-US United States - English

es-US United States - Spanish
es-UY Uruguay - Spanish

uz-UZ Uzbekistan - Uzbek (Cyrillic)
uz-UZ Uzbekistan - Uzbek (Latin)
vi-VN Vietnam - Vietnamese

ar-YE Yemen - Arabic

en-ZW Zimbabwe - English



Language Translation Editor

The translation editor simplifies the process of creating language
files.

It allows creation of new language files, or editing existing
language files.

How to edit a language file.
Start the language translation editor (‘treditor’)

1. Fromthe' File 'menuchoose’' Open language
file '
2. Locate your language file and open it.

3. Start editing.

If you want to start a new translation with an empty translation
column choose ' Create new language file 'from the'’
File 'menu

When you are ready to save the translation, choose' Save
language file' fromthe' File 'menu, and save it into the
'language’ folder. Be sure you save to the correct filename for
your language.

Important
Language files over-ride GenScribers internal language. If you
leave one of the translations blank, the blank will over-ride the
internal language.
If for example, is you left a phrase blank that was text for a
button, you would get a blank button.

When editing the translation, if you don't have a translation for a
particular phrase, just copy the english across using CTRL + E

File Menu

Create a new language file
When you open a language file with this option, the "Translation'
column will be empty, ready to start translating from new.

Open language file
This will open a language file and show the existing translations
in the 'Translation' column.

Save language file
Saves your current translation.
Language files are stored in the 'GenScriber/include/language'
folder.

Don't forget , the Language-Country code and Character
set must always be uppercase, and the suffix (.tr) must always
be lowercase.

The filename format of a language filename is always
“LANGUAGE-COUNTRY.UTF-8.tr"
Example: EN- GB .UTF-8.tr



A list of Language-Country codes can be found HERE

Merge language file
This option will merge 2 language files together.
It is only available when 'Advanced' is selected in the 'Options'
menu.

Quit

Ends the application

Options Menu

Advanded
Selects advanced editing.

One click edit
With this option ON, edit mode is activated with a single click in
a cell.
When OFF, a double click is required to start editing.

Auto select
With this option ON, text in cells is automatically select whenedit
mode is activated.
When OFF, a double click is required to select all text in cell.

Allow edit master
With this option ON, it is possible to edit the master column (Key
Phrases).
Warning: Changing Master Key Phrases will break the
translation. The main purpose for this option was for my own use
during development.
This is only available when 'Advanced' is selected in the
'Options’ menu.

Help Menu
Opens the pdf help file.

Sorting Columns
Columns may be sorted by click on the column header.
Sorting toggles each time the header is clicked
(assending,decending,nosort)

When editing
Ctrl+E  will copy the english key phrase cell to the
translation cell.

Some Key phrases have a coloured background. This is there to
alert you that they have special characters.

: There are tilds ( ~ ) in the cell that must be
copied into the translation exactly where they are.

BLUE : The first part of the phrase should not be translated.
Translate only the part AFTER v or a ,anddo not copy
anything else.

GREEN : t and n mustbe copied into the
translation exactly. only translate the text around these



characters.

%s and %d must be copied into the
translation exactly. only translate the text around these
characters.

All other special character should be copied into the translation
exactly as you see them.



Templates

It is quite usual to use GenScriber and never have need to
know about templates. GenScriber will automatically create
and save user templates for the worksheets you edit, and
each time a worksheet is opened the corrisponding
template is used.

Any changes you make to the column settings of a
worksheet will be saved in the template each time you quit
GenScriber.

Templates are formatted text files. If you really need to, you
can edit them using a text editor, but that is rarely
necessary.

A template file contains the structure of column widths,
limits, actions etc.

The user templates are stored in the ‘include/tmp folder'.
User templates will over-ride master templates that have
the same structure.

Master templates are stored in the ‘include/templates’
folder.

Creating Master Templates

First you need to save a worksheet you wish to make a
template from.

It does not matter if the worksheet contains data. We only
care about the column structure and options.

1. If the worksheet is not already open, then 'choose a
new template’, ‘create a new one' or open a csv file to
extract the template from.

2 .Clickonthe' Column Options 'tab, and select"’
Show Advanced Options '

3 . Add,Delete,Edit columns and set any options you
want as default.

4 . Save the worksheet, and then open it again, this will
ensure the options are updated in the user template.

5 .Clickonthe' Tools 'menu, and select’
Save Master Template '

6 . Give it a name and save it.

After saving, the template name will appear under the '
New Document(from template) 'menu.

Now, any worksheets created using this template will inherit



this templates default options

Note: The' Save Master Template 'menu only appears
if a master template does not already exist (  or if
template protection is turned off. seei

mportant note (1) ).

Important Note:

(1) Template protection can be disabled in' General
Options 'to allow modifying a master template.

Please Note. If you change the layout of a master template,
all worksheets previously created from the template will no
longer belong to it.

If you change the column headings or column positions of a
worksheet, then you have changed the worksheet structure,
and genscriber will create a new user template for it.

This user template will live in the tmp folder, where it will be
used each time you open a worksheet using the same

column layout. If a master template is changed, the original
worksheet will simply continue to use the old user template.

Creating Templates Manually

Predefined (master) templates are stored in the '

GenScriber/include/templates ' folder.
Template files may be organised into subfolders. The
template filename suffix is ".tpl'.

Templates are formatted text files, and you can edit them
using a text editor.

A template file contains the structure of column widths,
limits, actions etc.

The file is separated into sections using braces' {}

The 'file header' section contains the template name, and if
used, it may also contain other global settings.

example of the file header section:
{ TEMPLATE =Burials }
or
{ TEMPLATE = Burials » AUTHOR = Les Hardy }

These settings are terminated by ' » ' Note there is no
space between the > characters

The terminator ( » ) may be omitted from the last setting
in header section.

All sections that follow the header are field
sections.
Each field section contains a keyword and a value,
formatted as KEYWORD=value



The keyword value pair is separated by a single equal sign*

These settings are terminated by " »
no space between the > characters
The terminator ( » ) may be omitted from the last setting
in a field section.

All keywords must be Uppercase

Note there is

Line-feeds and spaces between settings are ignored.
Line-feeds in the 'HINT' text are recognised, and the bar (
| ) isalso converted to a line-feed.

Recognised file header settings are:
TEMPLATE
The template name. This is used once at the top of the file.

AUTHOR
Displays the author in the title bar. Useful to help recognise
your own templates.

PICKLISTDROP =0
Hides the fixedlist dropdown (do not confuse the with
PICKLIST, which activates the normal picklist)

FULLTEXT =#
Set a column as fulltext. Only a single column is allowed,
and it cannot be column 1.
# is the number of the column. FULLTEXT=4 would make
column 4 the fulltext edit area.
The fulltext field will display as a text area, to the right of the
worksheet.

Recognised field setting are:
FIELD The field (column) title.

VISIBLE
1= visible, 0 = hidden. Default=1 if omitted

WIDTH
The field (column) width. Default =100 if omitted.

PICKLIST
1= use picklist, if omitted or 0 = do not use picklist

AUTOINC
If omitted or O = no autoinc.
1= from current cell value, increment to bottom row.
2= increment from top row to bottom row (use top row value
as start)

AUTOFILL
If omitted or O = no autofill.
1= fill column with value of current cell.
2=fill column with value of current cell (overwrite existing
data)

AUTOCASE
If omitted or O = no autocase.
1= SentenceCase(strict) First character is uppercase. All
other characters are forced to lowercase.



2= SentenceCase First character is uppercase. All other
characters are left as is.

3= TitleCase First character of each word is uppercase.
4= UpperCase All uppercase.

5= LowerCase All lowercase.

AUTOREPEAT
If omitted or 0 = no autorepeat
1= copy contents of cell above.(do not overwrite current cell
data)
2= copy contents of cell above (overwrite current cell data)

HINT
The hint for this field (column). Omit or Leave blank for no
hint.

FIXEDLIST
The name of the FixedList to use for current column. Omit
or Leave blank for no fixedlist.

MAXCHARS
The maximum number of characters allowed in a cell.

HYPERLINK
Set the column to follow hyperlinks. 1= hyperlinks. if omitted
or 0 = no hyperlinks

The FIELD setting is always required. Other settings
are optional.

Defaults for omitted field settings are as follows:-
VISIBLE=1
WIDTH=100
PICKLIST=0
AUTOINC=0
AUTOFILL=0
AUTOREPEAT=0
AUTOCASE=0
HINT=
FIXEDLIST=
MAXCHARS=
HYPERLINK=0

Template Example.

The field sections below are fornmated in different ways to denonstrate t
{ TEMPLATE = Buri al s}

{

FI ELD = | mageNo >>

VI SIBLE = 1 >>

W DTH = 200 >>

HI NT = Enter the inmge nunber against the first entry on each new i mage,

}

{FI ELD=Recor dNo >> VI SI BLE=1 >> W DTH=100 >> PI CKLI ST=0 >> HI NT=
This is a hint.
Li ne feeds are recognised| This is also a new |line}



{ FI ELD=Day>>VI S| BLE=1>>W DTH=80>>HI NT=The day of the nonth}
{ FI ELD=Mbnt h>>AUTOCASE=1}

{
I}:I ELD=Year

Note: The separator (») may be omitted from the last
setting in a field section.

Important note:  Field(column) tittes must be
unique, and they must not contain special characters. The
column titles are used as a reference by some functions.
They are also case sensitive, 'Surname' is not the same as
‘'surname’

Spaces in titles should not be used.
' Father Surname ‘'and' Father Surname 'may
look the same to the eye, but the computer will see that the
first (with 2 spaces) as a different title to the second (with 1
space).
Errors like this can be extremely difficult to debug, so avoid
spaces in column titles.

The best way to format a title is to use 'medial capitals' in
compound words, also known as camel-case. ie.
FatherSurname.

You could multihyphenate ie. This-Is-A-Long-Title or
This_Uses_Underscore

Rules for FullText Edit.
There are a few rules when using the option to have a
fulltext editbox replace a column.

1. Only one column may be set as 'fulltext'.

2. The column number for the fulltext field must be
greater than 1.

3 .You cannot setthe following options on a
fulltext field:-
WIDTH, PICKLIST, AUTOINC, AUTOFILL, AUTOREPEAT,
AUTOCASE, HINT, FIXEDLIST, MAXCHARS, HYPERLINK

Example full text template header.

g’he fulltext field is WII_Details (field 4).
TEMPLATE=W | | s>>
FULLTEXT=4>>

Pl CKLI STDROP=0>>
AUTHOR=Les Har dy

}
{ FIELD=Title>> VI SI BLE=1>> W DTH=200 }

{ FI ELD=Ref er ence>> VI S| BLE=1>> W DTH=100 }
{ FI ELD=Dat e>>VI S| BLE=1>>W DTH=100>>HYPERLI NK=1 }
{ FIELD=W | Details>> }



Adding a unique ID to a column

Sometimes it is helpful to be able to identify a template from
other templates, even though the templates have
apparently identical columns. This can be done by adding
an 'ID' column

Adding a unique Id to a column
Add a column with a title that starts with  ID: , and then
add your unique id for that template.

example: ID:mytemplate-123

This will make the template unique, and tell genscriber that
thisisan' ID 'column. When genscriber findsan 1D
: column, it is hidden in the worksheet.

ID columns are useful for coordinators. Some useful
information can be stored in this column, and processed
when the transcription is returned to the coordinator.

There is one caveat. The software used to process returned
transcriptions will have to be capable of handling the extra
column(s)

If you are using condition scripting, please read about
'Functions' in the GenScriber-Scripting.pdf file.

Removing Existing Templates

To delete a master template
1. First quit GenScriber

2. Inthe GenScriber folder go into
include/templates/

3. Locate the template and delete it.

To delete a user template

1. First quit GenScriber

2. Inthe GenScriber folder go into' include/tmp/'

3. Locate the template and delete it.

Changing Template Structure Mid Stream

Although it should always be avoided, it may become



necessary to change a template structure while the
transcribers are using it.

The following attempts to explain when and how a
worksheet template can be change for worksheets that
already contain data.

Scenario One

Let us suppose that you're coordinating a project and
transcribers are using a template with the following
columns...

First_Name, Last_Name, Age
We will call this template * TPLO1 "

After transcribing has begun you realise more columns are
needed.

You add two columns to your original template (  TPLO1 )
and save itas TPLO2

The fields of the new template are...
First Name, Last Name, Age, Mother_Name,
Father_Name

If you don't change or remove any of the original column
titles, then the old template is just a subset of the new
template. It doesn't matter what order the new titles are in,
provided the original titles are in there, and are exactly the
same characters as before.

With this kind of template change it is not too difficult for the
transcriber to move over to the new template.

So let's assume you enabled 'Template Updates' and your
transcribers have the new template in their template folder.
They now have TPLO1 and TPLO2

Now for the instructions to the transcribers...

If it is your intention to discontinue TPLO1, then you can
instruct them to delete TPLO1 either before or after the
following is carried out.

How to transfer the existing data to the new
template.

1 . Start up GenScriber and in 'Preferences' ensure that
the option for 'Advanced Copy/Paste' is selected.

2. Open the original worksheet (csv file) that is
currently being used with the old template (TPLO1).

3. Inthe 'Edit' menu click on 'Copy All
The complete worksheet will be copied to the clipboard.

4 . Inthe 'File' menu select’ New Document from
Template ', and choose the new template ( TPL0O2 )

5 .Clickonthe' Special Paste 'toolbar button, and
then click the ' Paste ' button (bottom right).
All data from the original worksheet will be pasted into the
correct columns.



6 . Save the new worksheet. From now on the
worksheet will automatically use TPLO2.

Note: If any data is missing after the paste, it is
either because some of the original column titles do not
match the new column titles, or the 'Special Paste' option
was not selected in the Special Paste window.

Important Notes
When a predefined master template is attached to a
worksheet, it is cached in the ‘include/tmp’ folder. Therefore,
if the old template is delete and the old worksheet is
opened, the cached settings will still be used.

However, it will no longer be considered a master template.
It will revert to a user template, and will allow the user to
modify it as they wish.

All this really means is that if for some reason an older
worksheet needs to be opened, transcribers will still have
the settings for that worksheet.

Scenario Two
Let us suppose that your transcribers are using a template
with the following columns...

FullName, Age
We will call this template * TPLO1 "

After transcribing has begun you realise you should have

split the name.

You add another column to your original template (
TPLO1 ) and change the column titles, and save it as
TPLO2

The fields of the new template are...
First Name, Last_Name, Age

Because you changed the name of a column, it would be
impossible to match the original data to the new columns.
With this kind of template change it is quite difficult for the
transcriber to move over to the new template.

However, it can be done, and | will explain how.

How to transfer the existing data to the new
template.

1 . Delete the original template (TPLO1) (genscriber
must be closed)

2 . Start up GenScriber and in 'Preferences' ensure that
'Advanced Copy/Paste Button' is active.

3. Open the original worksheet (csv file) that is
currently being used with the old template (TPLO1).

4 . Go into the 'Column Options' tab and change the title
FullName 'to' First_ Name '

5 . Go back to the worksheet.




Video Tutorials

Below are a few short videos showing various
actions in GenScriber.
The video format is WebM, and is supported by most
browsers.
WebM will work in IE9+ and Safari/MacOSX provided
the user has the WebM codecs installed.

The videos do not have audio

Find and Replace

A quick demo of Find & Replace.
PLAY VIDEO

Sort Backwards

| find the ability to sort a column from right to left is very
useful. This short demo sorts a 'Full_Name' column by
Surname.

PLAY VIDEO

Sort Mixed Date Formats

Columns containing a mixture of date formats are
difficult to sort correctly. This special date sort does the
job. If you're not impressed, try this in excel and see
what happens.

PLAY VIDEO

Search Filter

Using the search filter to locate records quickly.
PLAY VIDEO

Opening a Gedcom


http://www.genscriber.com/download/video/find_and_replace.webm
http://www.genscriber.com/download/video/sort_backwards.webm
http://www.genscriber.com/download/video/sort_mixed_date_formats.webm
http://www.genscriber.com/download/video/search_filter.webm

Importing a gedcom file is as easy as opening it.
PLAY VIDEO

Changing the Layout

PLAY VIDEO

Image/Worksheet synchronisation in
action

PLAY VIDEO


http://www.genscriber.com/download/video/opening_a_gedcom.webm
http://www.genscriber.com/download/video/changing_the_layout.webm
http://www.genscriber.com/download/video/image_synchronisation.webm

Windows Character Map

The Character Map enables you to view the
characters that are available in a selected font.
Using the Character Map, you can copy individual
characters or a group of characters and paste
them into GenScriber.

During editing a worksheet cell you can insert
special characters from the character map.

To open the character map

1. Click on the Start (Windows lcon) menu in
the lower left, then select All Programs.

2. Select Programs > Accessories > System
Tools > Character Map.

3. A window should open which displays a
series of characters in a grid as in the image
below.

TIP: If you use the Character Map a lot, you
may want to make a Shortcut (alias) to it on
your Desktop or add it to your Start menu.

Using the character map

1. Click the Font list, and then click the font
you want to use.

2. Click the special character you want to
insert into the document.

3. Click Select, and then click Copy.

4. Click the location in the Worksheet cell or
TextPad where you want the special character to
appear.

5. Paste the character in one of the following
ways...
Right-click where you want to paste, and choose
'‘Paste’ from the menu.
Place you cursor where you want to paste and
hold down Ctrl and press V' (Ctrl+V)
Place you cursor where you want to paste, open
the Edit menu and choose 'Paste to cell



Tip: GenScriber allows you to drag special
characters into the cell being edited.
To do this, click the character you want to copy.
When the character appears enlarged, drag it
into the cell at the position you want to insert it,
and release the mouse button.






